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Introduction         
Experienced users should head down to this section in this document.  

Audacity ... 

a free cross platform audio editor.  

For new users to Audacity, see the Tutorial in 
five parts for some basics on digital audio, 
setting up Audacity, selecting, aligning, and 
recording.  

Audacity is currently in version 1.2.0. This is a 
stable release of Audacity; it has been tested 
and works well for most people. However, it 
comes with no guarantee, and we depend on 
your feedback in order to continue to improve 
on it. Please check our website for the latest 
version. Audacity is a collaborative project, so 
there are lots of opportunities for you to get 
involved if you're interested!  

http://audacity.sourceforge.net/ 

What can you do with 
Audacity? 

Audacity is a program that 
manipulates digital audio waveforms. 
In addition to recording sounds 
directly from within the program, it 
imports many sound file formats, 
including WAV, AIFF, MP3, and Ogg 
Vorbis. PCM formats of 8,16,24 and 
32-bits can be imported and 
exported. 

• Cut, Copy, Paste, Delete, 
Silence, Duplicate, Split  

• apply plug-in effects to any part 
of a sound  

• built-in volume envelope editor  
• customizable spectrogram track 

view mode  
• frequency analysis window for 

audio analysis applications  
• custom playback rate for every 

track, which is live-resampled to 
the project sample rate  

What can't Audacity do?  

Although Audacity is a very powerful 
audio editor that works with an unlimited 
number tracks of virtually unlimited size, 
it cannot do everything. It cannot :  

• Audacity cannot record more than 
two channels at once on many 
systems. Some support for 
multitrack recording is included in 
version 1.2.0, but it does not 
support very many systems yet.  

• Audacity opens MIDI files, but it is 
not a MIDI editor, and its MIDI 
features are extremely limited.  



• simple to complex align 
operations for tracks and groups 
of tracks  

How does it work - a quick intro for experienced 
users 

Audacity works with tracks, that 
contain one audio file. This file is 
editable and all actions are undoable. 
Undo's are instantaneous. 

Almost anything is undoable, including 
importing and deleting tracks!  

There are no inserts, auxes or buses 
yet. 

All versions can use LADSPA plugins, 
and the Windows and Mac versions can 
use VST plugins using the VST Enabler 
(a separate download).  

There is volume automation via the 
envelope tool. 

Editing functions include Cut, Copy, 
Paste,Duplicate(to new track at same 
timecode), Split(to new track at same 
timecode), and Silence. 

A grid can be activated for each track, 
and snapping can be switched on as 
well. 

What makes Audacity unique? 

• Audacity is free and the source code is available under the GNU General 
Public License.  

• Audacity is cross-platform - it runs on Windows (98 through XP), Mac OS X, 
and many Unix platforms, including Linux. Previous versions worked with Mac 
OS 9.  

• No limits on the number of tracks or the length of any track, except the size 
of your hard disk.  

• Import almost anything: WAV, AIFF, Next/AU, IRCAM, MP3, and Ogg Vorbis 
files are supported natively, but Audacity will also open just about any 
uncompressed sound file and automatically deduce the format (using the 
Import Raw Data... feature).  

• Audacity not only includes many high-quality effects built-in, but also lets you 
use LADSPA and VST plug-in effects. There are dozens of free, shareware, 
and commercial plug-ins online that do everything from Reverb to Noise 
Reduction.  

• Audacity supports plug-ins written in the Nyquist programming language, a 
high-level language designed specifically for working with audio.  

• Audacity acts like a non-destructive editor, providing multiple levels of undo, 
but it also writes changes made to the audio to disk, eliminating the need for 
complicated real-time processing.  

• Label tracks allow you to annotate waveforms (for example, transcribing 
speech) and later export the waveforms to a text file.  



• Powerful spectral features allow you to view waveforms as spectrograms or 
plot the power spectrum of any region of audio, and even export this data to 
a spreadsheet.  

• Pitch-changing and tempo-changing effects  
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What's New in Audacity 1.2 ??  
(History of Audacity) 

New features in Audacity 1.2: 

User Interface 

• New Mixer toolbar allows you 
to control the output volume, 
input volume, and input 
source directly from Audacity.  

• Every track now has its own 
gain and pan controls.  

• Uses improved project file 
format.  

• Block files (stored in Audacity 
project directories) now use 
the standard AU format. 
Though some Audacity meta-
information is in these files, 
they can now be read by 
many other popular audio 
programs as well.  

• Import RAW has a simpler GUI 
but support for far more file 
formats. The autodetection 
algorithms are much more 
accurate than in 1.0.  

• Using high quality resampling 
algorithms, with the option of 
better quality for mixing than 
for real-time playback  

• Preliminary support for Time 
Tracks, for changing playback 
speed over time  

• Vertical zooming of tracks.  
• Improved look and placement 

of toolbars.  
• New custom mouse cursors.  
• Complete implementation of 

editable keyboard shortcuts.  

Effects 

• Repeat Last Effect command  
• Support for LADSPA plug-ins 

on all platforms  
• VST support now comes 

through an optional LADSPA 
plug-in called the VST Enabler.  

• Most effects now have a 
Preview button  

• Compressor (Dynamic Range 
Compressor)  

• Change Pitch (without 
changing tempo)  

• Change Tempo (without 
changing pitch)  

• Change Speed (changing both 
pitch and tempo)  

• Repeat (useful for creating 
loops)  

• Normalize (adjust volume and 
DC bias)  

Audio I/O 

• 1-second preview command 
(just hit the '1' key on your 
keyboard)  

• Looped play (Shift-click on the 
Play button)  



• Find zero-crossings.  
• Mouse wheel can be used to 

zoom in and out.  
• Multi-Tool mode.  
• Amplify using envelope.  
• Labels can store selections 

(like Audacity 1.0.0).  
• Open multiple files from the 

same dialog.  

New features in Audacity 1.1.1: 

User Interface 

• Tooltips appear in Statusbar.  
• Vertical cursor follows 

play/record  
• Pause button  
• Drawing tool (with three 

different modes) 
Note: 
In v1.1.1 from Nov11th 2002, 
the smoothing tool (CTRL+click) 
crashes if used too close to the 
edge of a tracks audio. Stay 
away from the edges.  

• Vertical Resizing of stereo 
tracks is more fun.  

• Adjust selection by click-
dragging selection boundary  

• Toolbar button context-
sensitive enabling/disabling  

• Better zooming functionality 
(centers region)  

• Multiple ways to display the 
cursor position and selection  

• Snap-to selection mode  
• Drag tracks up and down  
• Align and group align 

functions  
• Cursor save/restore  
• Working history window  

Effects 

• Effects broken down into three 
menus: Generate, Effect, and 
Analyze  

• Generate menu lets you 
generate silence, noise, or a 
tone  

• Nyquist support (supports 

Mac OS X 

• Support for more audio 
hardware  

• Support for full-duplex (play 
while recording)  

• Support for MP3 exporting 
using LameLib Carbon  

Unix 

• Audacity now has a man page 
(it describes command-line 
options and how to set the 
search path)  

File Formats 

• Uses libsndfile 1.0, which fixes 
some bugs and improves 
performance  

Searching for Files: 

• On Windows and Mac OS, 
Audacity now looks for 
translations in the 
"Languages" folder and all 
plug-ins in the "Plug-ins" 
folder, relative to the 
program.  

• On Unix, Audacity looks for 
translations in /share/locale 
and looks for everything else 
in /share/audacity and also in 
any paths in the 
AUDACITY_PATH environment 



plug-ins written in Nyquist, an 
interpreted functional 
language based on Lisp)  

Localization 

• Improved localization support  
• More languages available  
• Language selection dialog on 

startup  

variable  

New features in Audacity 1.1.0: 

Core audio processing: 

• Support for 24-bit and 32-bit 
sample formats  

• Automatic real-time 
resampling (using linear 
interpolation)  

Effects: 

• Support LADSPA plugins on 
Linux / Unix  

File formats: 

• New XML-based Audacity 
project format  

• Full Ogg Vorbis support now 
(importing and exporting)  

• Export to any command-line 
programs on Unix  

• Support for reading and 
writing many more types of 
uncompressed audio files, 
including ADPCM WAV files.  

Toolbars 

• New toolbar drawing code; 
automatically adopts your 
operating system's colors  

• New toolbar buttons (Skip to 
Start, Skip to End)  

• New Edit toolbar  
• Toolbar buttons disable when 

they're not available  

User Interface 

• Fully customizable keyboard 
commands  

• Autoscroll while playing or 
recording  

• New Ruler, used in main view 
and in FFT Filter effect  

• The waveform now displays 
the average value in a lighter 
color inside the peak values  

Localization 

• Audacity can now be localized 
to different foreign languages.  

New libraries in Audacity 1.1: 

• libmad for fast MP3 importing  
• libid3tag for editing MP3 file information  
• libsndfile to read and write more audio file formats  
• PortAudio for cross-platform audio playing and recording  
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here you'd normally find links to stuff of the same category as the current page  

How to use this manual 
In this manual you'll find lots of common screen elements, that you can rely on to 

navigate this manual.  

TOP LEFT CORNER 
-
> 

Back to the main page. Having trouble with this? Take a 
nap and try again. 

TOP MIDDLE 
-
> 

Back to the previous page, in this case probably the main 
page 

BOTTOM MIDDLE 
-
> 

Back to the previous page, in this case probably the main 
page 

BOTTOM LEFT 
CORNER 

-
> 

Back to the main page 

To reiterate, to get back to the main contents page, check the top-left corner of 
the page.  

To return to the page above the current one in the manual, check the top-middle 
of the page.  

Any stuff that fits in to the same category of the current page is usually available 
as a link just above the page title and below the link back to the previous page.  

That way you can jump around all the tutorial pages that belong together for 
example.  

Keyword search 

We don't have one. That's why we have the Index of Terms. If you don't know where 
else to look, look here.  
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Tutorials  



I. Basics 

1. Digital Audio  
2. Rules of Audacity  
3. Setup, Audio Import and 

Playback  
4. Recording with Audacity  

II. Editing for 
Beginners 

1. Introduction to Editing...  
2. Cut, Copy & Paste  
3. Silence, Duplicate and Split  
4. Splitting and Submixes  

III. Common Editing 
Tasks 

1. Quickies  
2. Editing Vocal Tracks  
3. Cutting up long Tracks  

IV. Effects for 
Beginners 

1. A virtual room with Reverbs  

V. Selecting and Aligning 

1. Selecting  
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Digital Audio Rules of Audacity Setup, Audio Import and Playback Recording with 
Audacity  

Tutorial - I.Basics 
Part 1 -  Digital Audio  - Part 1 

What is sound?  

Sounds are pressure waves of air. If there wasn't any air, we wouldn't be able to 
hear sounds. There's no sound in space.  

We hear sounds because our ears are sensitive to these pressure waves. Perhaps 
the easiest type of sound wave to understand is a short, sudden event like a clap. 
When you clap your hands, the air that was between your hands is pushed aside. 
This increases the air pressure in the space near your hands, because more air 
molecules are temporarily compressed into less space. The high pressure pushes 
the air molecules outwards in all directions at the speed of sound, which is about 



340 meters per second. When the pressure wave reaches your ear, it pushes on 
your eardrum slightly, causing you to hear the clap.  

 

A hand clap is a short event that causes a single pressure wave that quickly dies 
out. The image above shows the waveform for a typical hand clap. In the 
waveform, the horizontal axis represents time, and the vertical axis is for 
pressure. The initial high pressure is followed by low pressure, but the oscillation 
quickly dies out.  

The other common type of sound wave is a periodic wave. When you ring a bell, 
after the initial strike (which is a little like a hand clap), the sound comes from the 
vibration of the bell. While the bell is still ringing, it vibrates at a particular 
frequency, depending on the size and shape of the bell, and this causes the nearby 
air to vibrate with the same frequency. This causes pressure waves of air to travel 
outwards from the bell, again at the speed of sound. Pressure waves from 
continuous vibration look more like this:  

 

How is sound recorded?  

A microphone consists of a small membrane that is free to vibrate, along with a 
mechanism that translates movements of the membrane into electrical signals. 
(The exact electrical mechanism varies depending on the type of microphone.) So 
acoustical waves are translated into electrical waves by the microphone. Typically, 
higher pressure corresponds to higher voltage, and vice versa.  

A tape recorder translates the waveform yet again - this time from an electrical 
signal on a wire, to a magnetic signal on a tape. When you play a tape, the 
process gets performed in reverse, with the magnetic signal transforming into an 



electrical signal, and the electrical signal causing a speaker to vibrate, usually 
using an electromagnet.  

How is sound recorded digitally ?  

Recording onto a tape is an example of analog recording. Audacity deals with 
digital recordings - recordings that have been sampled so that they can be used by 
a digital computer, like the one you're using now. Digital recording has a lot of 
benefits over analog recording. Digital files can be copied as many times as you 
want, with no loss in quality, and they can be burned to an audio CD or shared via 
the Internet. Digital audio files can also be edited much more easily than analog 
tapes.  

The main device used in digital recording is a Analog-to-Digital Converter (ADC). 
The ADC captures a snapshot of the electric voltage on an audio line and 
represents it as a digital number that can be sent to a computer. By capturing the 
voltage thousands of times per second, you can get a very good approximation to 
the original audio signal:  

 

Each dot in the figure above represents one audio sample. There are two factors 
that determine the quality of a digital recording:  

• Sample rate: The rate at which the samples are captured or played back, 
measured in Hertz (Hz), or samples per second. An audio CD has a sample 
rate of 44,100 Hz, often written as 44 KHz for short. This is also the default 
sample rate that Audacity uses, because audio CDs are so prevalent. 

• Sample format or sample size: Essentially this is the number of digits in 
the digital representation of each sample. Think of the sample rate as the 
horizontal precision of the digital waveform, and the sample format as the 
vertical precision. An audio CD has a precision of 16 bits, which corresponds 
to about 5 decimal digits. 

Higher sampling rates allow a digital recording to accurately record higher 
frequencies of sound. The sampling rate should be at least twice the highest 
frequency you want to represent. Humans can't hear frequencies above about 
20,000 Hz, so 44,100 Hz was chosen as the rate for audio CDs to just include all 
human frequencies. Sample rates of 96 and 192 KHz are starting to become more 
common, particularly in DVD-Audio, but many people honestly can't hear the 
difference.  

Higher sample sizes allow for more dynamic range - louder louds and softer softs. 
If you are familiar with the decibel (dB) scale, the dynamic range on an audio CD 



is theoretically about 90 dB, but realistically signals that are -24 dB or more in 
volume are greatly reduced in quality. Audacity supports two additional sample 
sizes: 24-bit, which is commonly used in digital recording, and 32-bit float, which 
has almost infinite dynamic range, and only takes up twice as much storage as 16-
bit samples.  

Playback of digital audio uses a Digital-to-Analog Converter (DAC). This takes the 
sample and sets a certain voltage on the analog outputs to recreate the signal, 
that the Analog-to-Digital Converter originally took to create the sample. The DAC 
does this as faithfully as possible and the first CD players did only that, which 
didn't sound good at all. Nowadays DACs use Oversampling to smooth out the 
audio signal. The quality of the filters in the DAC also contribute to the quality of 
the recreated analog audio signal. The filter is part of a multitude of stages that 
make up a DAC.  

How does audio get digitized on your computer? 

Your computer has a soundcard - it could be a separate card, like a SoundBlaster, 
or it could be built-in to your computer. Either way, your soundcard comes with an 
Analog-to-Digital Converter (ADC) for recording, and a Digital-to-Analog Converter 
(DAC) for playing audio. Your operating system (Windows, Mac OS X, Linux, etc.) 
talks to the sound card to actually handle the recording and playback, and 
Audacity talks to your operating system so that you can capture sounds to a file, 
edit them, and mix multiple tracks while playing.  

Standard file formats for PCM audio  

There are two main types of audio files on a computer:  

• PCM stands for Pulse Code Modulation. This is just a fancy name for the 
technique described above, where each number in the digital audio file 
represents exactly one sample in the waveform. Common examples of PCM 
files are WAV files, AIFF files, and Sound Designer II files. Audacity 
supports WAV, AIFF, and many other PCM files. 

• The other type is compressed files. Earlier formats used logarithmic encodings 
to squeeze more dynamic range out of fewer bits for each sample, like the u-
law or a-law encoding in the Sun AU format. Modern compressed audio files 
use sophisticated psychoacoustics algorithms to represent the essential 
frequencies of the audio signal in far less space. Examples include MP3 
(MPEG I, layer 3), Ogg Vorbis, and WMA (Windows Media Audio). Audacity 
supports MP3 and Ogg Vorbis, but not the proprietary WMA format. 

For details on the audio formats Audacity can import from and export to, please 
check out the Fileformats page of this documentation. Please remember that MP3 
does not store uncompressed PCM audio data. When you create an MP3 file, you 
are deliberately losing some quality in order to use less disk space.  

Next part - Rules of Audacity  
 
Back to the main page 
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II.Editing for Beginners 
Part 1 -  Introduction  - Part 1 

Sound Editing in the "real world" 

Sound editors clean up dialogue tracks, cut layers of special effects, place sounds 
at certain times, create ambiance tracks by cutting out unwanted stuff and mixing 
in interesting or necessary sounds. Music production engineers may cut pieces of 
vocals away or shift them to a another spot in a song. 

Editing is about cutting, placing, fading, cross-fading, shifting, duplicating and 
adjusting the volume (also referred to as level) of audio material. Mixing is a form 
of editing too of course. 

Here is an example of what is done in sound editing during the production of a 
television show or film. In the next part we will run you through a few of those 
techniques in Audacity. 

The Path of Sound in Film and TV Postproduction 

Film and TV crews have at least two people present that take care of recording 
sound during principal photography of a show. Principal photography is usually 
shooting the scenes with actual live actors or real backgrounds by the way. 

Sound in Principal Photography 

The first person is the boom pole operator. The boom pole is an extendible stick 
with a microphone attached to it. This is used to capture dialogue either during 
filming or not. When not filming, it might be capturing off-scene dialogue or 
retakes of lines that the actors flunked during actual film takes. The more 
expensive the show is and the more time there is to do the work, the more people 
will resort to looping those takes, which is recording those lines in a sound studio 
environment instead of a film studio or location. 

The second person is the sound mixer, who usually sits in a place farther off from 
the shooting and records the sound captures by the boom pole operator, either via 
cable or wireless devices to tape,optical disks or hard drive. 

This is the raw sound material of a show. It is called production sound and the 
only desirable parts it usually contains are dialogue and body sounds. In post 
production, depending on the complexity, budget size and time, almost everything 
you hear except for the dialogue and some body sounds, are added later during ... 



Post Production 

This is where most of the stuff we'll be describing for Audacity will happen. You've 
got the recording. Now what ? 

After the visual part of the show is cut, the first of which usually isn't the final one, 
it is handed to the sound editor. In TV shows, you'll usually have one or two 
people for this, for major film productions a whole bunch more, for which tasks will 
be subdivided on a finer level. 

Raw sound - Cleanup time 

No shows do without film edits and many have plenty of them. 

Scenes may be shot with with one or more cameras and mics. Actors might have 
flunked their lines and picking up shooting prior to the mistake might be chosen or 
the entire sequence reshot. The film editor may have chosen parts from different 
takes for the cut of the scene. The action might be moving along at the wrong 
pace and the film editor shortened or stretched parts of a scene. 

The sound editor makes sure transitions between cuts are smooth. He or she 
removes undesired sounds, such as breathers of the same person that overlap 
from one film edit to the next. 

Material is cut away that contains unwanted sounds, such as creaking chair legs 
and sharp impacts of objects on tables and floors. Some of these may require 
looping of dialogue in the studio, because the noise may have been intolerable. 
Also, material may sometimes be denoised. The most sophisticated methods 
remove the whirring of the camera motors from takes. It is used as sparingly as 
possible though. 

It's always desirable to get the best possible sound from the start, which is the 
recording stage. 

Adding stuff - the really big deal 

After this cleanup is complete, sounds are added. 

The first is ambiance. Just close your eyes and listen the sound around you. 
That's ambiance. Sophistication of ambiances rises with budgets. From premixed 
to over a dozen tracks, you'll find it all in TV shows and feature films. In any 
indoor scene with a lot of people in the background, nobody except for the actors 
being filmed will actually talk. That flurry of conversation is added later on. 

Next comes foley. These are clothes rustling(body sounds), foot steps and objects 
being handled. People that have the ultimate edition of Terminator 2 will know 
that all of Arnold Schwarzenegger's footsteps and rustle of his leather clothing 
were created by a five foot woman. These people are usually called foley walkers 
or foley artists. 



The foley editor then cleans those sound, chooses the most fitting takes and 
makes sure they all sync to the picture properly. The foley mixer then does his/her 
thing. 

Next come effects. Foley are effects too, but they are a special category and can 
best be described as live created studio effects. Effects are usually more heavily 
edited and recorded from all kinds of places. A lot of effects are created by 
layering sounds on top of each other, changing their pitch and loudness, editing 
bits out and adding others. 

Many effects you'll hear are phone and door bells ringing, mobile phone beeps, 
doors of houses and cars opening and closing, weapon shots, slaps, car skids, 
machines of any kind, space ships flying around, explosions, to name a few. 

For example, a friend of mine and I created the sound of a small wooden rowing 
boat hitting a larger wooden sailing ship and scraping along its side by pitching 
down a knock on a large wooden door for the impact of the rowing boat and ship, 
and pitching down the sound of a skateboard rolling and scraping along a halfpipe. 

The techniques required to properly handle sounds like these are used in all kinds 
of productions. Audio books, music production, sound effects creation ... you name 
it. 

For more on this subject, read the Audio Post FAQ at www.filmsound.org. 

So let's jump in to the fray and look at how you can handle your sounds in 
Audacity. 

proceed to 
Part 2 - Cut,Copy&Paste. 

Back to the main page  
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Tutorial - III.Common Editing Tasks 
Part 1 -  Quickies  - Part 1 

This page will give you an idea of some of the possible things you can do with 
Audacity and walk you through the process. 

1. Splitting an MP3 into two separate files 

2. Mixing background music with a voiceover 

3. Recording harmonies with yourself 

4. Recording two sound sources on separate tracks 



Splitting an MP3 into two 
separate files 

(Before you try to export MP3 files, 
read the section on Exporting MP3 Files 
for some important information on 
steps you need to do first.) 

• Open the MP3 file.  
• Select the part of it that you want 

to be the first file. Listen to it by 
clicking the Play button.  

• While this part is selected, choose 
Export Selection as MP3... from 
the File menu.  

• Now select the part you want to be 
the other song and Export again.  

Mixing background music 
with a voiceover 

Audacity makes it very easy to mix two 
different sounds together. 

• Open one sound (for example, the 
background music).  

• Select Import Audio... from the 
Project menu and open the other 
sound (for example, the 
voiceover).  

• Listen to your sound using the Play 
button. Audacity automatically 
mixes them together.  

• Choose the Time Shift tool and 
adjust the position of one track or 
the other until they're 
synchronized the way you want 
them. You can even move tracks 
around while they're playing.  

• If you hear clipping which wasn't 
present in either of the original 
files, it means that the combined 
volume of the two tracks is too 
loud. Select one or both of the 
tracks and then use the Amplify... 
effect to reduce the volumes until 
you don't hear clipping anymore.  

• Export as a WAV or MP3 file.  

Recording harmonies 
with yourself 

• Open the Preferences, click on the 
Audio I/O tab, and check the box 
marked "Play other tracks while 
recording new one".  

• Click the Record button. Record 
yourself singing. Click Stop.  

• Click the Record button again. The 
first track you recorded will play, 
but Audacity will also record a 
new track at the same time, 
allowing you to sing harmony with 
yourself.  

• When you play the two tracks you 
recorded together, they probably 
won't be synchronized. This is 
normal and is not the fault of 
Audacity. To fix it, you will need 
to grab the Time Shift tool and 
slide one of the tracks around until 
it sounds right.  

Recording two sound 
sources on separate 
tracks  

• Open the Preferences, click on the 
Audio I/O tab, and make sure 
"Record in Stereo" is checked.  

• Connect one sound source to the 
left channel of your soundcard and 
the other on the right. If you don't 
have an external mixer with a pan 
control, use a stereo/mono splitter 
cable.  

• Record your stereo track.  
• On the button with the track name 

is a drop-down menu. Select "Split 
Stereo Track" from this menu.  

• Use the drop down menu again to 
change each track to mono.  

• To make a panned stereo track out 
of each new mono track, select 
one track and choose Duplicate 
from the Edit menu. Reduce the 
level of one channel (using a 
negative value under Amplify in 



the Effect menu.) Then choose 
Make Stereo Track from the drop-
down menu on the first track.  

• Repeat as necessary for further 
tracks (see Recording harmonies 
with yourself above). If mastering 
from tape, a click recorded across 
all tracks will help you synchronize 
them in Audacity.  
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IV.Effect for Beginners 
Part 1 -  A Virtual Room with Reverbs  - Part 1 

An example by the numbers 

As an example I'd like to show you how to create a reverb for small club with a 
band.  

Let's see what we have to do with parameters in the reverb fx in sample editors. 
First we determine some basics about the room we want to simulate.  

Our room(the club) is about eight meters on all sides(for simplicity) and three 
meters high. The band will be playing no more than four meters away from us. 
The room volume will be about 200 cubic meters.  

This means that the DIRECT SOUND will get to you within about 11 ms 
(milliseconds). This is the amount of time we'll need to take off the other values.  

The first EARLY REFLECTIONS (off the left and right walls) travel around nine 
meters before reaching you, so they'll get to your ears about 15 ms later! (9 
meters at 343 meters/sec -> 26 ms minus the 11 ms the DIRECT SOUND takes to 
travel to your ears).  

I'm not taking the floor into account because of the obstacles, such as your own 
legs and a table, that prevent reflections of sound from the band from reaching 
you. It is also probable that your sitting close to a wall and EARLY REFLECTION 
time may drop considerably. Experiment and listen very carefully.  

The reason I'm deducting 11 ms from the 26 ms is that in a sample editor we 
already have the DIRECT SOUND. In Cool Edit an EARLY REFLECTIONS parameter 
doesn't exist. In Soundforge however there are a few ER times to choose from. We 
choose whatever is closest to 15 ms. Freeverb unfortunately does not have an 
Early Reflections feature.  



Please note that the timing of the EARLY REFLECTIONS are defined by the rooms 
characteristics such as shape and size. The sound colour of the EARLY 
REFLECTIONS is defined by the surfaces in the room.These are parameters that 
are available to professional reverbs only(hard- or software), so don't worry about 
not finding that stuff in great detail in either Soundforge's, CoolEditPro's or plugins 
of other editors.  

The PRE-DELAY and REVERB TIME depend on more than just room size. Wall and 
floor material, as well as anything else that reflects, disperses and dampens sound 
will influence the reverb in quite a few ways.  

Our club has lots of wood on it's walls and floor and people are sitting at tables 
and the air's probably filled with a little smoke(except in California :).  

The REVERB TIME, a parameter found in almost all plugins, should be set to no 
more than one second. In small, crowded rooms where little REVERB occurs it is 
quite important to set the EARLY REFLECTIONS right. Experiment with the reverb 
time keep it lower than 1.2 seconds and above 0.7 seconds. Freeverb puts all this 
information in to the SIZE parameter.  

The PRE-DELAY can be set to 30 ms or more. Larger rooms will develop REVERB 
later since the reflecting sound will travel a while before the reflections become 
hard to identify but it also depends on the reflecting materials. Freeverb once 
again doesn't know any Predelays, but since you're reading this to learn how 
things work, it's still worth spelling out.  

Both Cool Edit and Soundforge have parameters referring to the DENSITY of the 
REVERB part of the sound. Materials such as polished marble will reflect the sound 
very well and disperse the sound very little. Wood disperses the sound a lot and a 
carpet practically swallows a large chunk of it. For our Club we need to set the 
density high since our material disperses the sound a lot(humans,wood and 
obstacles). No parameter like that in Freeverb and yet it sounds great. It's easy to 
use as well, so I don't really mind when using it.  

Higher frequencies are swallowed a lot faster than low frequencies. Many reverb 
algorithms refer to this in some form or another. Cool Edit has the 'High Frequency 
Absorption Time' as a parameter for this. Sound Forge gives you a choice, whether 
to do this at all for both low and high frequencies and even lets you set them but 
doesn't provide any time parameters. Professional Reverb hardware such as 
Lexicon PCM 70,80&90 let you you control frequency and time of this, for low and 
high frequencies. Freeverb has the DAMPEN parameter for this.  

This can effectivly add to room's liveliness. A room full of people will absorb high 
frequencies a lot faster than an empty room, in which only the materials would 
make the difference, so in Cool Edit we'll set the 'High Frequency Absorbtion Time' 
very low, since we're in a crowded club. For Soundforge activate the 'Attenuate 
high frequencies above' box and set the frequency parameter to around 2000-
2500 Hz. Experiment a bit. The higher this frequeny and the longer the Absorbtion 
Time parameter in Cool Edit, the emptier and and colder your room will seem. In 
small rooms this can cause the room to sound very metallic. Sewer pipes and oil 
pipelines e.g.  



The Reverb EQs are the final processing stage and can change the sound 
dramatically. These Hishelf and Lowshelf EQs are found in almost ANY Reverb 
plugin and hardware unit. Freeverb has both in form of Hipass and Lowpass filters. 
These are not EQs. The parameters change the target frequencies of the filters. 
Again, listen.  

The last thing you have to do is set the balance between the WET signal and your 
original DRY signal. Here you can do as you please but remember that only very 
smoothed hard surfaces in big cavernous space create very loud reverbs. A church 
might do that if there aren't a big number of people and wooden benches in there, 
but a club doesn't :). Remember that in Audacity it is smarter to DUPLICATE the 
part you wish to add reverb to, and run the effect over that duplicate. The volume 
of that reverbed material is easier to control, so set the WET parameter in 
Freeverb to 0dB(->100%) and the DRY parameter to -endless(->0% left most 
slider position).  

So when you create your next 'soon-to-be-the-hit' song or want to put things in 
perspective, be sure to check the possibilities of adding dimension and scope to 
your material through clever use of reverbs. Put your snare to the front, the piano 
a little to the back, and the sax just a little in front of the drums. Experiment. With 
these basics you'll be able to get better results in less time.  

Btw, Snare always gets reverb. How much and what kind up to you, but it's a 
generaly good thing. It's also important to decide whether you're trying to 
simulate a real live band or doing a multitrack sound, which boasts all kinds of 
nice ideas, like doubling(another take of the same thing on top of the first take), 
extreme panning and in general NOT reality :).  

Dry versus Wet  

Have you heard of those silent rooms, where they test speakers and microphones 
? They're great if you don't happen to be inside of one. After a few minutes you 
hear the blood in your ears roar like an ocean. You hear only your inner voice 
when you speak. The room swallows almost everything else. Most people can't 
stand being in a room like this for more than 10-15 minutes. I am told that this is 
very different to wearing ear plugs. Those only attenuate sound from the outside. 
A silent room kills it completly.  

This room is horrible to listen to, because it basically features no room 
reverberation, i.e. it doesn't reflect anything at all. It doesn't reveal any 
information about its size or surface composition.  

You may be surprised to know that many vocals are actually recorded in similar 
enviroments. Vocal booths are little rooms, in which the walls reflect sound as little 
as possible. During mixing, digital reverbs are used to create a virtual space.  

Digital Reverbs  



Audacity for Windows and MacOS8&X includes the VST plugin Freeverb, which is 
one fine reverb, and idealy suited to take your first steps with digital reverbs. It 
features simple controls that require little explanation.  

For details about Freeverb, check out the effects menu page. For information on 
how digital reverbs work and what reverb is, check out this page of this manual.  

Keeping effects on seperate tracks  

You shouldn't use reverbs on original audio tracks. First duplicate the audio and 
use the reverb on that duplicate. The reverb should be set to output 100% WET 
(i.e. 100% effect signal and 0% of the original signal). That way, you can control 
how much reverb should make it in to the final mix, right up until the last minute.  

Back to the main page Back to the Tutorial Page   
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Selecting  

V.Selecting and aligning 
Part 1 -  Selecting  - Part 1 

Basic rules 

Selecting can be done with the keyboard, the mouse or by combining the 
keyboard and mouse. 

You need to have the Selection Tool activated for making a selection.  

The exception is selecting the entire track by clicking on the track panel. The 
align functions all still work the same way no matter which tool is activated. 
However, making selections and placing the cursor still requires the Selection Tool.  

The selection modifier key is SHIFT. 

In a word processor or text editor, the SHIFT key is the modifier to turn any 
character that you enter via the keyboard in to an UPPERCASE character. In 
Audacity and most audio editing applications, holding down the SHIFT key means 
that any cursor movement or placement will result in a selection. 

What follows are ways of making selections. 

How do I ... 



select audio on one track ? 

Place the cursor on the waveform of a 
track, hold down the mouse button, 
drag the mouse and release the mouse 
button.  
 
You can select audio with the keyboard 
as well, but may need to place the 
cursor with the mouse first. You need 
to hold down the SHIFT and use the 
left/right cursor keys to expand the 
selection. Combine the former with the 
CTRL key(STRG on the german 
keyboard) to shrink the selection. 

expand/shrink my selection ? 

Hold the SHIFT key, then click and hold 
the mouse button.  
 
If you clicked to the left of the center of 
the current selection, you will now be 
able to move the left selection 
boundary with your mouse. The same 
goes for the right hand side of the 
selection center. Release the mouse 
button when your satisfied.  
 
You can use the cursor keys as well. It 
works the same way as described in 
the previous item. 

select from the cursor to the 
start of the track ? 

Use the Start to Cursor function in the 
Edit menu. 

select from the cursor to the 
end of the track ? 

Use the Cursor to End function in the 
Edit menu. 

select from the cursor to the 
start of the project ? 

Hold the SHIFT key and click on the 

select all the audio of a track ? 

Click on the track panel. The resulting 
selection will be confined to the 
contents of that track. 

select all the audio of two or 
more tracks ? 

It cannot be done precisely right now, if 
one track isn't within the range of the 
other.It actually doesn't have to be, 
because of the group functions in the 
Align menu, but more of that later.  
 
If the start and end of one track is 
within the start and end of the other, 
simply select the longer track, then 
SHIFT + click the second track panel.  
 
If the start and end of one track is not 
within the start and end of the other, 
select the one track, then expand the 
selection by SHIFT + clicking in to the 
second track until the selection 
encompasses all the desired material. 

select all the audio of the 
project ? 

Use the Select All function in the Edit 
menu, or hit CTRL+A. 



Skip to Start button. 

select from the cursor to the 
end of the project ? 

Hold the SHIFT key and click on the 
Skip to End button. 
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File Menu 

New... 

Creates a new empty project window. 

Open... 

Selecting Open presents you with a 
dialog where you can choose a file to 
open. If the current project window is 
empty, the new file will take over the 
current window, otherwise a new 
project window will be opened. 

The file formats recognized by Audacity 
are 
WAV,   AIFF,   NeXT/AU,   IRCAM,   
MP3,   Ogg Vorbis,   MIDI, and the 
Audacity Project file format (AUP). 

In addition, Audacity can also attempt 
to open an audio file in a different 
format, as long as it is uncompressed - 
to do this, use the Import Raw Data 
command. 

Close 

Closes the current project window. 

Save Project 

Saves the current Audacity project 
(AUP) file. Audacity projects are not 
intended to be read by other programs, 
but they are extremely fast to load and 
save within Audacity. When you are 
finished working on a project and you 

Export As WAV... 

Exports the current Audacity project as 
a standard audio file format such as 
WAV  or  AIFF. 

You can change the format of exported 
files in the Preferences dialog. 

If there are multiple tracks of the same 
channel in your project, they will be 
automatically mixed in the exported 
data. For more information about 
mixing, see Quick Mix. 

To export only a single track or part of 
a track, use Export Selection. 

Export Selection As WAV... 

This is the same as Export, but it only 
exports the part of the project that is 
selected. This is very useful if you want 
to save a small clip from part of a track 
as a separate file. 

Export As MP3... 

Exports the current Audacity project as 
an MP3 file. Audacity does not encode 
MP3 files directly, but instead requires 
that you download a separate MP3 
encoder. See Exporting MP3 Files for 
details. 

To export only a single track or part of 



want to be able to use it in another 
program, select one of the Export 
commands instead. 

Note that most of the audio data for an 
Audacity project is not stored in the 
AUP file, but in a directory (folder) with 
the same name as the project. For 
example, if you save a project as 
chanson.aup, there will be a directory 
called chanson_data created to store 
the actual audio tracks of the project. 
For more information on the project file 
format, see the file formats page. 

Save Project As... 

Saves the current Audacity project 
(AUP) file, allowing you to give it a 
different name or move it to a new 
location if you have already saved it in 
one location. 

Audacity projects are not intended to 
be read by other programs, but they 
are extremely fast to load and save 
within Audacity. When you are finished 
working on a project and you want to 
be able to use it in another program, 
select one of the Export commands 
instead. 

For more information on the project file 
format, see the file formats page. 

track, use Export Selection as MP3. 

Export Selection As MP3... 

This is the same as Export MP3, but it 
only exports the part of the project that 
is selected. This is very useful if you 
want to save a small clip from part of a 
track as a separate file. See Exporting 
MP3 Files. 

Export As OGG... 

Exports the current Audacity project as 
an Ogg Vorbis file.  

To export only a single track or part of 
track, use Export Selection as Ogg. 

Export Selection As OGG... 

This is the same as Export As OGG, but 
it only exports the part of the project 
that is selected. This is very useful if 
you want to save a small clip from part 
of a track as a separate file.  

Export Labels... 

If you have any Label Tracks, this 
command will export them as a text 
file. This feature is commonly used in 
Speech Recognition research to 
annotate a speech utterance and 
export the annotation to be later 
processed by another program. 

To import these labels into a different 
project later, use the Import Labels 
command. 

Preferences 

Opens a dialog window that lets you 
configure Audacity. For more 
information on the different 
preferences, see the section on 
Audacity Preferences. 



Exit/Quit 

Closes all project windows and exits 
Audacity. It will ask you if you want to 
save changes to your project. It is not 
necessary for you to save changes if 
you just exported your file as WAV or 
MP3 and you are finished working with 
it. On the other hand, if you are 
working on a mix and plan to continue 
where you left off, saving an Audacity 
Project will let you restore everything 
as it is later.  
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Edit Menu 

Undo 

This will undo the last editing operation you 
performed to your project. Audacity 
currently supports full unlimited undo - 
meaning you can undo every editing 
operation back to when you opened the 
window. 

Redo 

This will redo any editing operations that 
were just undone. After you perform a new 
editing operation, you can no longer redo 
the operations that were undone. 

Cut 

Removes the selected audio data and places 
it on the clipboard. Only one "thing" can be 
on the clipboard at a time, but it may 
contain multiple tracks. 

Copy 

Copies the selected audio data to the 
clipboard without removing it from the 

Paste 

Inserts whatever is on the 
clipboard at the position of the 
selection cursor in the project, 
replacing whatever audio data is 
currently selected, if any. 

Trim 

Deletes everything but the 
selection. 

Delete 

Removes the audio data that is 
currently selected without copying 
it to the clipboard. 

Silence 

Erases the audio data currently 
selected, replacing it with silence 
instead of removing it completely. 



project. 

  

Split 

Moves the selected region into its own track 
or tracks, replacing the affected portion of 
the original track with silence. See the figure 
below: 

 

Duplicate 

Makes a copy of all or part of a track or set 
of tracks into new tracks. See the figure 
below: 

 

Split at Labels 

Uses the split function to give you 
separate tracks for every label. 
The source track remains 
unchanged. 

Select the label track(click on the 
track panel), then select the track 
you wish to split by 
SHIFT+click'ing on its track panel. 
Now activate the Split by Labels 
function. 

The result is that for each label, a 
new track will be created that 
contains a duplicate of the 
material up to the next label or 
the end of the track, whichever 
comes first. 

Select All 

Selects all of the audio in all of the 
tracks. 

Select Start to Cursor 

Selects all the audio from the start 
of the timeline to the current 
cursor. 

Select Cursor to End 

Selects all the audio from the 
cursor to the end of project, which 
is as far as audio exists in the 
project. 
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View Menu 



Zoom In  

Zooms in on the horizontal axis of the 
audio, displaying more detail about less 
time. You can also use the zoom tool to 
zoom in on a particular part of the 
window.  

Zoom Normal 

Zooms to the default view, which 
displays about one inch per second.  

Zoom Out 

Zooms out, displaying less detail about 
more time.  

Fit in Window 

Zooms out until the entire project just 
fits in the window.  

Set Selection Format 

Sets the format in which selections are 
measured in at the bottom the 
application window. Combined with 
setting Set Snap-To Mode to ON, this is 
ideal to cut stuff up in to exact 
measures.  

Set Snap-To Mode 

Snap-To-Grid On or Off. This only has 
influence on making selections. 
Especially useful, when combined with 
the cdda selection format when cutting 
up tracks for CD burning.  

History 

Brings up the history window. It shows 
all the actions you have performed 
during the current session, including 
importing. The right-hand column 
shows the amount of HD space your 
operations used. You can jump back 
and forth between editing steps quite 
easily by simply clicking on the entries 
in the window.  

The history window can be kept open at 
all times. It doesn't interfere with any 
other operations.  

Plot Spectrum 

To use this feature, first select a region 
of audio from a single track, then select 
"Plot Spectrum".  

It opens up a window which displays 
the Power Spectrum of the audio over 
that region, calculated using the Fast 
Fourier Transform. The graph 
represents how much energy is in each 
frequency.  

This window can also display other 
common functions that are calculated 
using the Fast Fourier Transform, 
including three versions of the 
Autocorrelation function.  

The Enhanced Autocorrelation function 
is very good at identifying the pitch of a 
note.  

Float of Unfloat Palette 

Toggles between displaying the tool 
palette docked at the top of each 
project window, or in a separate 
floating window. You can also float the 
tool palette by grabbing the handle on 
the left side and dragging it to the 
location you want. 
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Project Menu 

Import Audio... 

This command is used to import audio 
from a standard audio format into your 
project. Use this command if you 
already have a couple of tracks, and 
you want to add another track to the 
same project, maybe to mix them 
together. 

Use this command to import anything 
except MIDI files. You cannot yet use 
this option to import Audacity Projects. 

Import Labels... 

This command takes a text file which 
contains time codes and labels, and 
turns them into a Label Track. 

Import MIDI... 

This menu command imports MIDI files 
and puts them into a Note Track. 
Audacity can display MIDI files, but 
cannot play, edit, or save them yet. 

Import Raw Data... 

This menu command allows you to 
open a file in virtually any format, as 
long as it is not compressed. When you 
select the file, Audacity will look 
through it and try to guess its format. 
It will guess correctly about 90% of the 
time, so you can try just pressing "OK" 
and listening to it. If it is not correct, 
however, you can use the dialog 
presented to try all of the different 
possibilities. 

At the beginning of your imported 

Quick Mix 

This command mixes all of the selected 
tracks down to one or two tracks. The 
channel of a track being mixed affects 
whether it will be mixed into the left 
channel of the resulting track(s), the 
right channel, or both (mono).  

For example, if you have four tracks:  

• Track 1: left channel  
• Track 2: left channel  
• Track 3: right channel  
• Track 4: mono channel  

and you select them all and perform a 
Quick Mix, you will end up with two 
tracks: the first will contain a mix of 
tracks 1, 2, and 4 (the new left 
channel) and the other will contain a 
mix of tracks 3 and 4 (the new right 
channel). 

Your tracks are implicitly mixed 
whenever you hit the Play button and 
whenever you select Export. 

Note that if you try to mix two very 
loud tracks together, you may get 
clipping (it will sound like pops, clicks, 
and noise). To avoid this, you should 
first use the Amplify... command to 
reduce the amplitude of all of your 
tracks. A future version of Audacity will 
do automatic gain control and calculate 
the optimal amplitude for you. 

New Audio Track 

This creates a new empty audio track. 
This command is rarely needed, since 
importing, recording, and mixing 



track(s), you may notice a little bit of 
noise. This is probably the file's header, 
which Audacity was not able to parse. 
Just zoom in and select the noise with 
the Selection Tool, and then choose 
Delete. 

Edit ID3 Tags... 

Opens a dialog allowing you to edit the 
ID3 tags associated with a project, for 
MP3 exporting. 

ID3 Tags are used to store the Title, 
Artist, Author, and other information in 
MP3 files. When you import an MP3 file, 
Audacity remembers this information 
and stores it with your project. When 
you export an MP3 file, Audacity will 
prompt you for the ID3 tags, showing 
you any tags it collected from an 
original MP3 file, or that you typed by 
selecting "Edit ID3 Tags" from the 
Project menu. 

Audacity allows you to store ID3 tags in 
either the ID3v1 or the ID3v2 format. 
In general, you should use the ID3v2 
format, because ID3v2 tags go at the 
beginning of an MP3 file, whereas 
ID3v1 tags go at the end. Having the 
title and author first means that 
someone downloading an MP3 you 
created will know that information 
before they've finished downloading the 
song. 

automatically create new tracks as 
needed. But you can use this to cut or 
copy data from an existing track and 
paste it into a blank track. 

New Label Track 

This creates a new Label track, which 
can be very useful for textual 
annotation. See the discussion on Label 
tracks for more information on how to 
use label tracks. 

Remove Track(s) 

This command removes the selected 
track or tracks from the project. Even if 
only part of a track is selected, the 
entire track is removed. You can also 
delete a track by clicking the X in its 
upper-left corner. To cut out only part 
of the audio in a track, use Delete or 
Silence. 

  
 

Cursor or Selection Save 

Saves the current cursor position. If a 
selection has been made, it also saves 
that. This function only saves the 
cursor position and selection 
boundaries, but not the actual audio 
data. 

Cursor or Selection Restore 

Restores the cursor position and 

Cursor to Track Start 

Places the cursor at the beginning of 
the current track's audio. 

Cursor to Track End 

Places the cursor at the end of the 
current track's audio. 



selection. Cursor to Selection Start 

Places the cursor at the beginning of 
the current selection. 

Cursor to Selection End 

Places the cursor at the end of the 
current selection. 

  
 

-> Align <- functions 

All the align functions work on whole tracks or groups of tracks, NOT on selections, 
even if they span across multiple tracks. Please read the tutorial on how to use the 
align functions. You will also find some creative uses and solutions to common 
problems there. 

Align Tracks Together 

If you select multiple tracks, this 
command adjusts their time offset so 
that they start at the same time. It 
adjusts their starting time to the 
average of all of the tracks' original 
starting times. To adjust the time offset 
of one track, use the Time Shift tool. 

Align with Zero 

If you select multiple tracks, this 
command resets their time offset to 
zero. To adjust the time offset of one 
track, use the Time Shift tool. 

 
 

 
These functions operate on each track individually. 

If more than one track is selected, these functions do not preserve their position to 
one another. 

Align with Cursor 

Aligns the start of any selected tracks 
to the cursor position. 

Align with Selection Start 

Aligns the start of any selected tracks 
to the start of the current selection 

Align with Selection End 

Aligns the start of any selected tracks 
to the end of the current selection 

Align End with Cursor 

Aligns the end of any selected tracks to 
the cursor position. 

Align End with Selection Start 

Aligns the end of any selected tracks to 
the start of the current selection 

Align End with Selection End 

Aligns the end of any selected tracks to 
the end of the current selection 

 



 
 

Groups refer to more than two selected tracks, 
which get shifted as if they were one track. This preserves their position to one 

another. 

Align Group with Cursor 

Aligns the start of any group of 
selected tracks to the cursor position. 

Align Group with Selection 
Start 

Aligns the start of any group of 
selected tracks to the start of the 
current selection 

Align Group with Selection End 

Aligns the start of any group of 
selected tracks to the end of the 
current selection 

Align Group End with Cursor 

Aligns the end of any group of selected 
tracks to the cursor position. 

Align Group End with Selection 
Start 

Aligns the end of any group of selected 
tracks to the start of the current 
selection 

Align Group End with Selection 
End 

Aligns the end of any group of selected 
tracks to the end of the current 
selection 
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Generate Menu 

Silence 

Inserts silence. The length is 
determined by the length of your 
selection and the position by the left 
boundary of your selection. 

If no selection is made, the default 
length inserted at the cursor position is 
30 seconds. 

For example, to insert a two seconds of 
silence at a certain point, place the 
cursor at your chosen spot, hold the 
SHIFT key down, click and drag your 
mouse to the right to mark roughly two 

Tone 

Inserts a wave of chosen type, 
frequency and amplitude. The length is 
determined by the length of your 
selection and the position by the left 
boundary of your selection. 

If no selection is made, the default 
length inserted at the cursor position is 
30 seconds. 

Parameters: 

Waveform Sine, Square, Sawtooth 

Frequency(Hz) 1-20000 (value below 
1.0 and above 20000 
will be corrected to 1.0 
and 20000!) 



seconds, release the mouse button and 
activate the Silence function in the 
Generate menu. Silence, the length of 
your selection, will be inserted at the 
left boundary of your selection.  

Frequency(Hz) 1-20000 (value below 
1.0 and above 20000 
will be corrected to 1.0 
and 20000!) 

Amplitude 0-1 - This is the volume 
of the generated wave.  

White Noise 

Inserts white noise. The length is 
determined by the length of your 
selection and the position by the left 
boundary of your selection. 

If no selection is made, the default 
length inserted at the cursor position is 
30 seconds. 

Pluck 

Inserts a synthesized pluck tone. The 
length is determined by the length of 
your selection and the position by the 
left boundary of your selection. 

If no selection is made, the default 
length inserted at the cursor position is 
one second. 

Pitch 0-127  
The number corresponds to the 
value of a midi note, which is 
assigned to a pitch. The higher the 
number, the higher the note.   
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Effects Menu 

Audacity includes many built-in effects and also lets you use plug-in effects (VST 
plug-ins) in the MacOS and Windows versions. You can download many free VST 
plugins at http://www.databaseaudio.co.uk. Loads of information is also available 
at http://www.kvr-vst.com. 

To apply an effect, simply select part or all of the tracks you want to modify, and 
select the effect from the menu. Titles which end in an ellipsis (...) will bring up a 
dialog asking you for more parameters. 

There are four classes of effects and they are all applied the same way. These are  

Internal Effects, VST Effect Plugins(Windows/Mac only), Nyquist Effects and LADSPA 
Effects(Linux only).  

Internal Effects 



Amplify... 

This effect increases or decreases the 
volume of a track or set of tracks. 
When you open the dialog, Audacity 
automatically calculates the maximum 
amount you could amplify the selected 
audio without causing clipping (from 
being too loud). 

Bass Boost... 

This is a safe, smooth filter which can 
amplify the lower frequencies while 
leaving most of the other frequencies 
alone. It is most effective if you don't 
try to boost too much; 12 dB is usually 
just right. 

Echo... 

A simple delay line. 

This effect repeats the audio you have 
selected again and again, softer each 
time. There is a fixed time delay 
between each repeat. 

First select the audio you want to apply 
the effect to. You may want to first add 
silence to the end of your track(s) so 
that the echo has plenty of time to die 
out. When you select "Echo..." from the 
Effect menu, Audacity will ask you for 
two numbers.  

The first number is the amount of delay 
between the echos, in seconds. The 
second value is the decay factor, which 
is a number between 0 and 1. A decay 
factor of 0 means no echo, and a decay 
factor of 1 means that each echo is just 
as loud as the original. A value of 0.5 
means that its amplitude is cut in half 
each time, so it dies out slowly. Smaller 
values will make it die out even more 
quickly. 

The Echo effect is very simple and is 
not intended to be used in place of a 

Invert 

This effect flips the audio samples 
upside-down. This normally does not 
affect the sound of the audio at all. It is 
occasionally useful, for example when 
the left and right channels of a song 
both contain equal amounts of vocals, 
but unequal amounts of background 
instruments. By inverting one of the 
channels and not the other, the vocals 
will cancel each other out, leaving just 
the instrumentals. Obviously this only 
works if the exact same vocal signal is 
present in both of the channels to begin 
with. 

Noise Removal... 

This effect is ideal for removing 
constant background noise such as 
fans, tape noise, or hums. It will not 
work very well for removing talking or 
music in the background. 

Removing noise is a two-step process. 
In the first step, you select a portion of 
your sound which contains all noise and 
no signal, in other words, select the 
part that's silent except for the noise. 
Then choose Noise Removal... from 
the Effect menu and click Get Profile. 
Audacity learns from this selection what 
the noise sounds like, so it knows what 
to filter out later. 

Then, select all of the audio where you 
want the noise removed from and 
choose Noise Removal... again. This 
time, click the "Remove Noise" button. 
It may take a few seconds or longer 
depending on how much you selected. 

If too much or not enough noise was 
removed, you can Undo (from the Edit 
menu) and try Noise Removal... again 
with a different noise removal level. 
You don't have to get a new noise 
profile again if you think the first one 
was fine. 



Reverb effect, which simulates the 
sound of a room, concert hall, stage, or 
other natural environment. Audacity for 
MacOS and Windows comes with 
FreeVerb, a free VST Reverb plug-in. 
See FreeVerb, below, for more 
information. 

Note that if you set the decay value to 
1.0, you can use Echo to create loops 
that repeat as long as you want any 
never change volume. 

Fade In 

Applies a linear fade-in to the selected 
audio. For a logarithmic fade, use the 
envelope tool. 

Fade Out 

Applies a linear fade-out to the selected 
audio. For a logarithmic fade, use the 
envelope tool. 

FFT Filter... 

This effect is fully functional but the 
dialog box is unfortunately still under 
construction. You can still use it, but 
there are no axes to tell you which 
frequencies are which, or how much 
gain you're applying. 

This is the most general type of filter. If 
you're careful, you can use it to 
highlight exactly the frequencies you 
want. However, doing an FFT filter is 
more likely to result in artifacts, 
especially if the filter you draw is not 
smooth. 

Removing noise usually results in some 
distortion. This is normal and there's 
virtually nothing you can do about it. 
When there's only a little bit of noise, 
and the signal (i.e. the voice or the 
music or whatever) is much louder than 
the noise, this effect works well and 
there's very little audible distortion. But 
when the noise is very loud, when the 
noise is variable, or when the signal is 
not much louder than the noise, then 
the result is often too distorted. 

Future versions of Audacity may 
include improved versions of this effect. 

Phaser... 

The name "Phaser" comes from "Phase 
Shifter", because it works by combining 
phase-shifted signals with the original 
signal. The movement of the phase-
shifted signals is controlled using a Low 
Frequency Oscillator (LFO). 

Reverse 

This effect reverses the selected audio 
temporally; after the effect the end of 
the audio will be heard first and the 
beginning last. Some people reverse 
small portions of audio to make 
inappropriate language unintelligible, 
while others believe you can hear 
subliminal messages if you listen to 
speech backwards. You can also create 
interesting sound effects by recording 
natural events and reversing the audio. 

Wahwah... 

Just like that guitar sound so popular in 
the 1970's. 

This effect uses a moving bandpass 
filter to create its sound. A low 
frequency oscillator (LFO) is used to 
control the movement of the filter 
throughout the frequency spectrum. 



The WahWah effect automatically 
adjusts the phase of the left and right 
channels when given a stereo 
recording, so that the effect seems to 
travel across the speakers. 

  

VST Plug-ins 

To use a VST plug-in effect, put the effect in the directory (folder) called "VST", 
which should be in the same directory where Audacity resides. If there is no 
directory called VST, create one. The next time you launch Audacity, any plug-ins 
you added will appear in the Effect menu. 

Freeverb2... 

Audacity for Mac OS and Windows 
comes with a VST plug-in called 
Freeverb, which is in version 2 (hence 
"Freeverb2"). This effect implements a 
versatile and high-quality reverb effect. 

Getting a good reverb sound depends a 
lot on the source audio and can take a 
lot of experimentation. One good 
strategy is to select a small portion of 
audio (a few seconds) and try to add 
reverb. Listen to it, then Undo and try 
it again with different settings. Keep 
doing this until you've found the 
settings you like the sound of best, and 
then Undo one last time, Select All, 
then apply the effect to your entire 
recording. 

There are a lot of parameters to 
Freeverb2: Room size, Damping, 
Predelay, Lowpass, Highpass, Wet 
level, and Dry level. 

Let's start with the wet and dry levels. 
Freeverb works by taking your audio 
signal and modifying it to create the 
reverberated sound, i.e. the sound you 
hear echoing off the walls of the room. 
This is called the "wet" part of the 
effect. 

This is mixed together with the original 

If you set the dry level to 0 and the wet 
level to -infinity, it's like standing right 
in front of the singer in a tiny room - all 
you can hear is the singer, and no 
reverb. A good place to start is to set 
both the dry level and wet level to 0 
dB. However, you may want to 
experiment with lowering the dry level 
while you are experimenting with the 
sound of the reverb. 

The room size parameter is self-
explanatory. The smallest room size 
setting creates a quick, bright reverb, 
while the largest setting creates a long, 
drawn-out, and dark reverb. The 
damping parameter controls how the 
sound bounces off the walls - i.e. if it is 
mostly reflected or absorbed. 

The predelay controls the delay 
between the dry signal 
(unreverberated) and the wet signal 
(reverberated) - usually there is some 
predelay because of the time it takes 
sound waves to travel from the sound 
source to the nearest wall, and to the 
microphone. Larger predelays are 
suitable for creating an effect of a 
larger room. 

Finally, the lowpass and highpass filters 
can be used to make the reverberated 



sound, which is called the "dry" part of 
the effect, to produce the combination 
of direct (unreverberated) and indirect 
(reverberated) sound, which is what 
you would naturally hear. If you set the 
dry level to -infinity and the wet level 
to 0 dB, the result is something like 
standing outside of a concert hall: you 
can only hear the reverberated sound. 

sound lower or higher. Increasing the 
lowpass filter filters out the high 
frequencies, and similarly increasing 
the highpass filter filters out the low 
frequencies. 

  

Nyquist Plugins 

To use a Nyquist effect, put the effect in the directory (folder) called "nyquist", 
which should be in the same directory where Audacity resides. Upon installation, 
some nyquist scripts are included, so you needn't worry about creating this 
directory. The next time you launch Audacity, any plug-ins you added will appear 
in the Effect menu. 

LADSPA Plugins 
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Analyze Menu 

Note: LADSPA plugins(Linux only) that except input but produce no output will be placed 
in the Analyze menu.  

Beat Finder 

no documentation available yet 

Sample Analyze Nyquist Plugin 
... 

Will place labels that mark the 
beginning and end of a selection. 
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Toolbars 



Main Toolbar 

 

  

I/O Sliders and Input Selector 

 

  

Edit Toolbar 
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Main Toolbar 

   

   

 Selection Tool 

This is the main tool you use to 
select audio. Click in a track to 
position the cursor, or click and 
drag to select a range of audio. 
If you drag from one track to 
another, you can select 
multiple tracks. Extend a 
selection by shift-clicking a new 
point in the track. 

Playback will always begin at 
the position of the selection 
cursor. If a range of audio is 
selected, only the selected 
range will play. 

 Envelope Tool 

      

 Cursor to Start 

Places the cursor at the start of the project. 
SHIFT + click expands the selection to the 
start of the project. 

 Play Button 

Press the play button to listen to the audio in 
your project. You can also hit the spacebar to 
start or stop playback. Playback begins at the 
current cursor position. If a region of audio is 
selected, only the selected region will play. To 
quickly play the entire project, execute Select 
All before playing. If there are multiple tracks 
going to the same channel in your project, 



The envelope tool gives you 
detailed control over how 
tracks fade in and out, right in 
the main track window. When 
the envelope tool is selected, 
the amplitude envelope of each 
track is highlighted in a green 
line, with control points at the 
beginning and end of each 
track. To change a control 
point, click it and drag it to a 
new position. To add a new 
point, click anywhere in the 
track where there is not 
already a control point. To 
remove a point, click on it and 
drag it outside of the track until 
it disappears, then release. 

 Time Shift Tool 

This tool allows you to change 
the relative positioning of 
tracks relative to one another 
in time. To use this tool, simply 
click in a track and drag it to 
the left or right. To align two 
tracks together or reset their 
time shift back to zero, use the 
Align Tracks Together or Align 
with Zero commands. 

 Zoom Tool 

This tool allows you to zoom in 
or out of a specific part of the 
audio. To zoom in, click 
anywhere in the audio. To 
zoom out, right-click or shift-
click. If you have a middle 
button, you can middle-click to 
do the same thing as Zoom 
Normal. 

In addition, you can zoom into 
a region by clicking and 
dragging the mouse to 
highlight the region you want 
to see, then releasing the 

they will be mixed automatically for playback. 

 Record Button 

Press the record button to record a new track 
from your computer's sound input device. Use 
the Preferences to configure the recording 
options. In particular, there is an option to 
record stereo or mono, and there is an option 
to play the other tracks while recording, which 
doesn't work on all systems. 

Recording always happens at the project's 
sample rate. 

 Pause Button 

Will pause during playback, or during 
recording. Press again to unpause. 

 Stop Button 

Press the stop button or hit the spacebar to 
stop playback immediately. 

 Cursor to End 

Places the cursor at the end of the project. 
SHIFT + click expands the selection to the 
end of the project. 



mouse button. 

 Draw Tool 

Enables the user to draw in to 
the actual waveforms. This is 
especially useful to eliminate 
small pops and clicks from 
material.  
ALT + click smoothes a area of 
audio  
CTRL + click & hold edits only 
one sample, no matter whether 
you move the mouse left or 
right.  
Note: 
In v1.1.1 from Nov11th 2002, the 
smoothing tool (CTRL+click) 
crashes if used too close to the 
edge of a tracks audio. Stay away 
from the edges.  
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I/O Sliders and Input Selector 

 
Output Input Input Selector 

These sliders control the mixer settings of the soundcard in your system.  

The sliders will jump to zero(left most position) if the drivers do not expose these 
functions. This is the case with some digital I/O cards of RME and possibly others 
as well. On these cards you will not be able to control the anything with these 
sliders.  

Output Slider 

This is the left hand slider that lets 
you control the output level of your 

Input Slider 

This is the right hand slider that lets you 
control the input level of the input type 



soundcard. It actualy controls the 
output setting of the soundcard 
driver. 

Should your output sound distorted, 
this is not the first place to look. You 
might get lucky though, so give it a 
quick slide. Usualy however, the 
distortion comes from the mix of your 
project clipping. You actualy need to 
reduce the level of your tracks. It is 
suggested to reduce every track by 
the same amount.  

selected in the Input Slider Selector. It 
actualy controls the that particular 
setting of the soundcard driver. 

What you record is also determined in 
the mixer software of your soundcard. 
There you can switch certain sources on 
and off, such as the Line Input, the 
Microphone Input or the CD Audio.  

After selecting the corresponding input 
source in the Input Slider Selector, you 
can control the level of that source going 
in to the recording with this slider.  

Should your input sound distorted, you 
should lower this slider untill no 
distortion can heard. 

For recording, it is advised to turn down 
all sources you do not wish to record. If 
turned up they only add noise. 

Input Selector for the Input Slider 

Pick the input source you wish 
to control with the Input 
Slider. All these items are 
exposed by the soundcard 
driver, so this will vary with 
different soundcards. 

 

Here is an example of an ESS 
1969 soundcard with the Line 
In selected. 
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Edit Toolbar 
All these tools perform the exact same function, as those accesible through the 

Edit menu, View menu and keyboard shortcuts.  

      



 Cut 

Removes the selected audio data and 
places it on the clipboard. Only one 
"thing" can be on the clipboard at a 
time, but it may contain multiple 
tracks. 

 Copy 

Copies the selected audio data to the 
clipboard without removing it from the 
project. 

 Paste 

Inserts whatever is on the clipboard at 
the position of the selection cursor in 
the project, replacing whatever audio 
data is currently selected, if any. 

 Trim 

Deletes everything but the selection. 

 Silence 

Erases the audio data currently 
selected, replacing it with silence 
instead of removing it completely. 

 Undo 

This will undo the last editing 
operation you performed to your 
project. Audacity currently supports 
full unlimited undo - meaning you can 
undo every editing operation back to 
the last time the document was saved. 

 Redo 

This will redo any editing operations 
that were just undone. After you 
perform a new editing operation, 
including simply resizing a track, you 
can no longer redo the operations that 
were undone. 

 Zoom In 

 Zoom Out 

 Zoom to Selection 

 Zoom to entire Project 
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Tracks 



  Audio Tracks 

  Label Tracks 

  Time Tracks 

  Note Tracks 

 Track Delete Button 

 
Vertical Track Resizing 

 

Audio Track Controls 

 Track Pop-Down Menu 

 Solo Button 

 Mute Button 

 

 

Gain and Panning Controls 
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Audio Tracks 
Audio tracks 
contain 
digitally 
sampled 
sounds. In 
Audacity, a 
channels of 
sound is 
represented 
by one mono 
audio track, 
a two 
channel 
sound by 
one stereo 
audio track. 
Each audio 
track has a 
sample rate: 
common 
values 
include 8000 
(telephone), 
16000 
(speech), 
22050 
(many 
games of 
recent 

 



years), 
44100 (CD 
Audio), and 
48000 
(DAT).  

From 
Audacity 1.2 
on, you can 
specify a 
different 
sample rate 
for each 
track. You 
can import 
audio of any 
sample rate 
or bit depth 
and Audacity 
will resample 
and convert 
it to the 
project rate 
and bit 
depth on the 
fly, as well 
as upon 
Export. You 
can choose 
different 
sample rate 
conversion 
qualities for 
playback and 
Exporting.  

(Note that in 
Audacity 1.0, 
all tracks 
must be at 
the same 
sample rate 
as the 
project.)  
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Label Tracks 
Label Tracks can be used to annotate an 
audio file. They can be used for lyrics, 
markers, or notes, and they can even 
be used to save selections.  

 
 

 
 

To create a Label Track, select New 
Label Track from the Project Menu. 
Alternatively, simply click or select 
where you would like to place a label, 
and choose Add Label at Selection from 
the Project Menu, and a Label Track will 
be created automatically if one doesn't 
already exist.  

To add a new label, click or select 
where you want the new label to 
appear, then select Add Label at 
Selection from the Project Menu, then 
type the name of the label, and finally 
press Enter or click outside of the label.  

 

 
  

To edit the name of a label, click 
anywhere in it. Zoom in first if there are 
too many labels crowded together and 
you are unable to click on the one you 
want. When a label is selected for 
editing, it looks like the first label 
below:  

When editing the name of a label, you 
are limited to using just the backspace 
key for editing. There is no way to move 
the insertion point to append a letter to 
the beginning of a label.  

Once a label is selected, you can move 
to the next label by pressing Tab, 
and move to the previous label by 
pressing Shift-Tab.  

 

 
  

To delete a label or multiple labels, 
select the area containing the label flags 
you wish to delete, and choose Silence 
from the Edit Menu. Alternatively you 
can delete an individual label by clicking 
on it and pressing Backspace until you 
have deleted all of the characters in the 
label, then pressing Enter.  

To move labels, use the normal editing 
commands like Cut, Copy, Paste, 
Delete, and Silence.  

You can save a selection in a label. 
When you create a new label, the left 
selection edge determines the position 
of the label's flag. However, the right 
selection edge is also stored in the 
label, and when you click on it, the full 
original selection will be restored.  

If you wish to apply this selection to 
only a subset of the tracks, shift-click in 
the label area to the left of each track's 
waveform to change whether each track 
is part of the selection or not.  



 
 

 

Exporting and Importing label tracks 
Label Tracks are saved when you save 
an Audacity Project, so if you just want 
to continue using the labels along with 
the same file, just save a project. But 
you can also export the labels to a 
simple text file, and import them.  

This allows you to save information 
about the locations of events in an 
audio file for use in another program,  

and also provides a way to mass-edit 
the labels if necessary.  

To export a Label Track, choose Export 
Labels... from the File Menu. The 
exported file will contain one line per 
label, starting with the time offset in 
seconds, then a tab, and then the name 
of the label, for example :  

 
  

1.217995    Bass intro 
3.921073    Guitar enters 
7.584454    Drums enter 
11.070002   Chorus 

To import a Label Track, choose Import Labels... from the File Menu.  
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Time Tracks 
This track consists of a 
single envelope.  

It controls the playback 
speed within a given 
range, i.e. it facilitates 
envelope-based 
resampling. The 
envelope handing is 
exactly the same as for 
the volume envelope.  

Clicking on the track 
panel reveals a few 
options, similiar to the 
ones of the track panel of 

 
  
  

 



an audio track.  

"Set Range" lets you set 
the minumum and 
maximum range of 
pitching. It is expressed 
in percentage values 
relative to 100%.  

 

Start by choosing New 
Time Track from the 
Project Menu. Then 
change the range of time 
warping by clicking on 
the Track Pop-Down 
Menu and choosing Set 
Range (an option which 
only appears for Time 
Tracks)  

You can also optionally 
choose the converter 
from a choice of 5 
algorithms, from fast and 
low quality to slow and 
high quality.  

Older computers may be 
incapable of playing 
audio in real-time that 
makes use of a Time 
Track, however you can 
always Export the file as 
a WAV and then playback 
the WAV file later.  

To edit the time warping, choose the envelope tool 
from the Control Toolbar - the same tool you use to 
edit amplitude envelopes in Audio Tracks. Click to 
create and edit control points. Drag points off-
screen to delete them.  

The Time Track has a ruler. As you edit the 
warping, the ruler will warp to show you at what 
time playback will reach each place in the audio.  
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Note Tracks 
Note tracks display data loaded from a MIDI file. 

They are currently not editable or playable. 

It's best to ignore the note tracks for now untill further 



notice. 
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Track Delete Button 
    Clicking on this button deletes the track. This action is undoable.  

Back to the Track page  
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Vertical Track Resizing 
For horizontal resizing, which is called zooming, visit the View Menu page. 

Vertically resizing a track is fairly simple.  

• Click and hold the mouse button on the 
resizing handle (see figure),  

• move mouse up or down until the track 
has the wanted vertical size  

• release mouse button   

  

Note: 

Stereo tracks have two resize handles. The one beneath the upper track lets you 
resize both tracks in relation to one another.  

The resize handle beneath the lower track resizes both tracks equally the same way. 
It changes the overall vertical size of the whole stereo track.  

Back to the Track page  
 
 
Back to the main page Back to the Track page   



Delete Pop-Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing  

Pop-Down Menu 

 

Name Edit the name of the track 

  

Move Track Up/Down Move Track Up or Down in 
the display 

  

Waveform Traditional display of audio 
material. It displays the 
amplitude of the audio over 
time. It is the default 
display mode. 

Spectrum Displays the frequency 
spectrum of the audio over 
time. 

Pitch(EAC) Tries to detect the pitch of 
the current audio and 
displays that information 
over time. 

  

Mono Set playback of this single 
channel track on the left 
and right channels. 

Left Channel Set playback of this single 
channel track on the left 
channel. 

Right Channel Set playback of single 
channel track on the right 
channel. 

Make Stereo Track The selected track and that 
beneath it is turned in to 
one stereo track. 

Split Stereo Track Turn one stereo track in to 
two single channel tracks. 

  

Set Sample Format Pick the sample format for 
this track. The result is that 
all newly written data is 
written in this format, no 
matter what format the 
original material was in. 
Newly written data can be 
output by effect and 
generator plugins for 
example.  



Newly written data can be 
output by effect and 
generator plugins for 
example.  

  

Set Rate Set the sample rate of this 
track. Upon import, the 
track sample rate is set to 
that of the imported 
material. A resampling 
feature is planned, so 
sounds of different sample 
rates can be combined in to 
one project. Right now, if 
the audio sample rate is 
different to the project 
sample rate, you have to 
resample the audio before 
importing it, so it plays at 
the correct speed in 
Audacity. 
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Track Solo Button 
 Clicking on this button will switch this track to solo mode. This action is not 

reversible with the Undo function, but you can un-solo a track simply by 
clicking it again.  

 In solo mode, only tracks that have the solo button activated (turning the 
button red), will be played.  

To deactivate the solo mode for that track, click on the button again. (button 
turns grey again)  

The state of the solo buttons is NOT saved in the project file, and it does not 
affect Exporting or Mixing.  
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Back to the main page Back to the Track page   
Delete Pop-Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing  

Track Mute Button 
 Clicking on this button will mute this track , i.e. this track is switched off 

without deleting it. This action is not reversible with the Undo function, 
however you can un-mute a track just by clicking the mute button again.  

 Muted tracks are easy to spot, because their Mute buttons are green.  

To unmute the track, click on the button again. (button turns grey again)  

The state of the mute buttons is NOT saved in the project file, and it does not 
affect mixing (i.e. muted tracks are still mixed when you export or Quick Mix).  
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Gain and Panning Controls 

 
 Gain (Volume) 

This slider controls the track volume, or rather the overall gain of that 
particular track.  

It's default position is in the middle, as shown in the picture to the left. 
This setting represents 0 dB.  

Tip: Normally the control moves in increments of 3 dB. 
Hold down Shift to adjust by 1 dB at a time.   

  

 
 Pan 

This slider set the panning position of the track in the stereo field.  

It's default position is in the middle, as shown in the picture to the left.  

Tip: Normally the control moves in increments of 10%. 
Hold down Shift for finer control.   

 
Back to the Track page  



 
 
Back to the main page Back to the Reference page   

Preferences 
Audio I/O 

• The first control or set of controls in this pane is where you configure which 
device Audacity should use for sound input and output. For example, some 
people might have two sound cards, and they want to select which one to 
use. Some computers have a built-in microphone, and this is also where you'd 
select whether you want to record from there or from the line-in jack on your 
sound card. No need to adjust this if Audacity is already playing to and 
recording from the correct place.  

• Record in Stereo: If this is checked, recordings you make in Audacity will be 
stereo, otherwise they will be monaural. Note that the interpretation of mono 
recordings depends on your system - on most systems making a mono 
recording of a stereo input will result in the two channels being mixed, but on 
other systems it could give you just the left channel, for example.  

• Play other tracks while recording new one: Check this box if you want to 
record multiple tracks over top of one another! Record the first track as usual. 
Then, with this box checked, click record again. The first track you recorded 
will play, but Audacity will also record a new track at the same time, maybe 
allowing you to sing harmony with yourself or add real-time sound effects to a 
recording.  
You may notice that when you play the two tracks you recorded together, 
they aren't synchronized. This is normal and is not the fault of Audacity. To 
fix it, you will need to grab the Time Shift tool and slide one of the tracks 
around until it sounds right.  
Note that this is not the same as playthrough, which means having the 
computer play the track that you are currently recording, as you are 
recording it. You may be able to enable this using your operating system's 
Mixer, but Audacity cannot enable this directly.  

Quality 

This panel sets the default sample rate and bit depth for new projects. It does not 
affect any existing project - to change the sample rate of an existing project, just 
click on the rate at the bottom of the window and select a new rate from the pop-
up menu. 

The bit depth affects imported material, if it's copied, as well as newly recorded 
material. The advantage of the 32-bit float resolution is that effects return 
material at a this resolution, which improves the final mix, because the computer 
has more precise material to work with. 

File Formats  



• When importing uncompressed audio files...  
o Make a copy of the file to edit: selecting this means that Audacity will 

run a little bit slower, but it will always have its own copy of any audio 
you are using in a project. You can move, change, or throw away your 
files immediately after you open or import them into Audacity.  

o Edit the original in place: selecting this operation means that 
Audacity depends on your original audio files being there, and only 
stores changes you make to these files. If you move, change, or throw 
away one of the files you imported into Audacity, your project may 
become unusable. However, because Audacity doesn't need to make 
copies of everything, it can import files much more quickly this way.  

• Uncompressed Export Format: This lets you select the format that 
Audacity will use when you export uncompressed files, i.e. anything other 
than lossy formats, such as OGG and MP3. Audacity can output a huge 
amount of different formats with the Other option, which lets you define any 
aspect of the multitude of different formats.  

• Ogg Export Setup: Use this control to set the quality of Ogg Vorbis 
exporting. Ogg Vorbis is a compressed audio format similar to MP3, but free 
of patents and licensing fees. A normal quality Ogg Vorbis file is encoded with 
a quality setting of "5". Note that unlike MP3 encoding, Ogg Vorbis does not 
let you set a bitrate, because some audio clips are easier to compress than 
others. Increasing the quality will always increase the file size, however.  

• MP3 Export Setup: Use these controls to locate your MP3 encoder and set 
the quality of MP3 encoding. Higher quality files take up more space, so you 
will need to find the level of quality you feel is the best compromise. For more 
information, see Exporting MP3 Files.  

Spectrograms 

You can view any audio track as a Spectrogram instead of a Waveform by 
selecting one of the Spectral views from the track's pop-up menu. This dialog lets 
you adjust some of the settings for these spectrograms.  

• FFT Size: The size of the Fast Fourier Transform (FFT) affects how much 
vertical (frequency) detail you see. Larger FFT sizes give you more bass 
resolution and less temporal resolution, and they are slower.  

• Grayscale: Select this for gray spectrograms instead of colored ones.  
• Maximum Frequency: Set this value anywhere from a couple of hundred 

hertz to half the sample rate (i.e. 22050 Hz if the sample rate is 44100 Hz). 
For some applications, such as speech recognition or pitch extraction, very 
high frequencies are not important (visually), so this allows you to hide these 
and only focus on the ones you care about.  

Directories 

Use this panel to set the location of Audacity's temporary directory. Audacity uses 
this directory whenever you work on a project that you haven't saved as an 
Audacity Project (AUP file) yet. You have to restart Audacity (close and open it 
again) for changes to the temporary directory to take effect.  



Interface 

• Autoscroll while playing 
Pageflips to the right when the cursor travels to the right end of the wave 
display, either during playback or recording.  

• Update Spectrogram while playing 
Tries to keep the spectrogram updated while playing. This requires a lot of 
CPU power, and really isn't a good idea unless you're playing a really small 
piece. In combination with Autoscroll while playing this can cause pauses 
during playback.  

• Enable Edit Toolbar 
Gives you a toolbar of a few useful functions. Check out the page on the Edit 
Toolbar for more information.  

• Language 
Lets you change the language of the menus and other onscreen text to the 
language of your choice, if you really have to change it again after picking 
your language when Audacity started the first time. Simply enter the right 
language code, close and restart Audacity. Check the language directory in 
the installation directory to see what languages are available to you.  

Keyboard 

• Commands/Key Combination List 
All commands in Audacity that can be triggered by a keyboard shortcut is 
listed here. Click on the shortcut and the assigned shortcut is highlighted in 
the command/shortcut list. Click on the "Clear" button to erase the shortcut 
assigned to the function selected in the Commands column.  

• Adding new shortcuts/changing shortcuts 
Click on the command in the list. Click in to the field next to the "Set" button 
and press any key or combination of command key(Shift,CTRL,ALT) and 
alphanumeric key(everything else). The description of that key or key combo 
will appear in the field or replace the shortcut. By clicking on the "Set" button, 
you can add or change this key or key combo as a shortcut to the function 
selected in the Commands list.  

Head over to this page for step-by-step description of the dialog and how to edit 
the command/keyboard combination list with a text editor.  
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Keyboard Shortcuts 



!!Apple MacOS X users!! CTRL = Command  

File Commands 

New Project CTRL+N 

Open Project CTRL+O 

Close Project CTRL+W 

Save Project CTRL+S 

Preferences CTRL+P 

Editing Tools 

Selection Tool F1 

Envelope Tool F2 

Editing Tool F3 

Zoom Tool F4 

Timeshift Tool F5 

Multi Tool F6 

cycle tool forward D 

cycle tool backward A 

Edit Commands 

Undo CTRL+Z 

Redo (Windows) CTRL+Y 

Redo (Mac/Unix) CTRL+SHIFT+Z 

Cut CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Navigation, Playback & 
Recording 

Play/Stop SPACE 

Loop SHIFT+SPACE 

 L 

Pause P 

Record R 

Preview 1 second 1 

Play From Cursor 
To Selection 

B 

    

    

Zoom In CTRL+1 

Zoom Normal CTRL+2 

Zoom Out CTRL+3 

Fit In Window CTRL+F 

Fit Vertically CTRL+SHIFT+F 

Zoom to Selection CTRL+E 

    

Import Audio CTRL+I 

Create Label CTRL+B 

    

Repeat Last Effect CTRL+R 
 



Delete CTRL+K 

 DELETE 

Silence CTRL+L 

Duplicate CTRL+D 

Select All CTRL+A 

    

Find Zero 
Crossings 

Z 
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Edit or Create 
Keyboard Shortcuts 

Where ? 
In the preferences dialog, go to the keyboard section or edit the keyboard 
configuration file directly with a text editor. You will find this file in the directory 
where you installed Audacity. Its filename is Audacity-keys.xml .  

Audacity will NOT load this keymap upon startup, but save them in the 
registry(Windows). Should you make changes to the Audacity.xml file with a text 
editor, you'll need to load that shortcut file with the "Load" button to make 
Audacity use them. Thus you can save your keymaps under any filename with an 
XML extension and keep different keymaps around for different purposes.  

Audacity will NOT store the current keymap in the file Audacity.xml. Should you 
want to make changes to the current keymap with a text editor, you'll have to use 
the "Save" button to save that keymap to an XML file first. After editing it you'll 
have to "Load" it again.  

Editing and Creating Shortcuts with the Preferences 
Dialog 



 

Changing 
a 
shortcut: 

1. Click 
on 
the 
com
man
d in 
the 
list. 
The 
com
man
d to 
be 
chan
ged 
is 
now 
highli
ghte
d.  

2. Click 
in to 
the 
box 
to 
left 
of 
the 
Set 
butto
n. If 
a 
short
cut 
was 
assig
ned 
to 
the 
com
man
d 
previ
ously
, it 
will 
be 
displ



ayed 
in 
this 
box.  

3. Hit 
the 
key 
or 
key 
comb
inati
on 
you 
wish 
to 
assig
n to 
this 
com
man
d. 
Then 
proc
esse
d to 
the 
next 
step.  

4. Click 
on 
the 
Set 
butto
n to 
assig
n the 
chos
en 
key 
or 
key 
comb
inati
on to 
the 
chos
en 
com
man
d.  

Clearing 



a 
shortcut: 

1. Click 
on 
the 
com
man
d in 
the 
list. 
The 
com
man
d to 
be 
clear
ed is 
now 
highli
ghte
d.  

2. Click 
on 
the 
clear 
butto
n to 
clear 
the 
com
man
d.  

Editing and Creating Shortcuts with a text editor 

The keyboard shortcuts you were editing with the dialog are stored in a simple 
XML file. Thus, you can edit it with any text editor.  

Each keyboard map starts with 

<audacitykeyboard audacityversion="1.2"> 

and ends with 

</audacitykeyboard> 

Each command is defined with the command tag. An example : 



   <command name="Undo" label="Undo" key="Ctrl+Z" />. 

name 

The actual command as Audacity understands it. 

label 

Command description as seen in the Preferences keyboard map editor. 

key 

This is the actual shortcut. Check out what the format is in the Preferences dialog. 
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How do effects work in Audacity ? 

Basic Calculus of Acoustics 

 
Reverb Delay Chorus  

 
  

Looking for a description of the stuff in the Effects Menu ?  
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How do effects work in Audacity ? 
1. Select some audio  

Use the mouse or keyboard shortcuts to select some audio. You can listen to that 
selection as many times as you like and adjust the boundaries of the selection.  



2. Select an effect  

You can pick any of the internal effects or a VST plugin(Windows & Mac). 
LADSPA(Linux) support is available in the 1.1 beta, but it's beta so be extra 
careful.  

3. Tweak the parameters to your liking  

Play around, go wild, honk your horn. Make those tough decisions without telling 
anyone why.  

4. Let the software work  

Hit the OK button. Or hit the Cancel button if you're unsure about something, like 
what time you were supposed to take the pizza out of the oven.  

5. Not happy ? UNDO  

That effect didn't cut it ? Did that delay show up too late and you wondered where 
the summer went ? No problem.  

Hit UNDO in the Edit menu (or press CTRL+Z).  

Then go back to 3. In fact you can hit undo so many times, YOU might disappear. 
Or perhaps just all your edits. Who knows.  
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Basic Calculus 
of 

Acoustics 
This is so terribly useful for so many things. You can use this stuff to calculate just 
how bad parallel walls are for sound, because of Standing Waves. What's that ? 
Coming attractions include exciting info on how to improve the acoustics of your 
room and what standing waves, bass traps and reflecting will do for your listening 
karma.  

You may enjoy finding out that a $1000 subwoofer won't work in a small 3x3 
meter room, 'cause the big energy bass action will happen beyond your walls. 
After all, the first energy peak happens at 1/4 of wavelength. Check it for yourself 



and get smart the next time you buy those 'gotta get buried with/under/in them' 
speakers.  

This all happens in plain fresh air:  

The speed of sound is 343 meters per second at 20 degrees Celsius  

+/- 0.6 m/s for every degree Celsius more/less ( -> 340 m/s at 15 degrees 
Celsius)  

c = lambda * f 
speed of sound = wave length * frequency 

  

x = (1000 / c ) * y 
time [milliseconds] = time[ms] for one meter * distance [meters] 

Examples (at 20 degrees Celsius -> c = 343 m/s):  

distance [meters] time [milliseconds] 

0.34 1 

3.43 10 

6 18 

10 29 

50 188  
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Reverb 
What is Reverb ? 

A Reverb simulates the component of sound that results from reflections from 
surrounding walls or objects. It is in effect a room simulator. Some people think 
it's just a delay effect with some filters, but it's way more complex than that. 
Reverb effects (software plugins or external hardware units) provide an interface 
to their changeable parameters that need some explaining. Let's look at a simple 
room first.  

Basic Simulation of a Room 



Our model is a simple room with four straight walls, a sound source and a 
listener. In Figure 1 the arrows stand for the path of traveling sound.  

The listener hears the DIRECT signal first. The DIRECT signal is also referred to as 
the DRY part of the signal when using any effect. Most digital reverbs produce two 
parts: The Early Reflections and the Reverb component.  

I. Early Reflections 

 
Figure 1 

The first Early Reflection 
reaches the listener 
milliseconds after the direct 
signal does.  

The path of the Early 
Reflections is longer. The 
difference in time between 
the arrival of the direct signal 
and the first Early Reflections 
is measured in milliseconds.  

II. Reverb 



 
Figure 1 

The sound reflects off the 
walls and objects in the room, 
and in time individual 
reflections disappear and the 
Reverb develops.  

Predelay 
The time between the 
reception of the DIRECT signal 
by the listener and start of the 
Reverb portion of the effect is 
called Predelay. This is a 
parameter in many digital 
reverb effects, and it is 
expressed in milliseconds 
(ms).  

Reverb Time 
The time difference between 
switching off any sound 
generator and the level of the 
reverb resulting from that 
sound dropping by 60dB is 
called RT60.  

This is usually referred to as 
the Reverb Time. When 
anyone refers to the reverb 
time of a real room or that of 
a digital reverb, RT60 is what 
they're talking about.  

Most digital reverbs feature 
this as a parameter.  

Common parameters of a digital Reverb 

Early Reflections Usually controlled via Room type and/or Room Size 
parameters.  

The EARLY REFLECTIONS enable the human brain to 
quickly identify the room size. They are therefore the 
most critical part of a reverb effect, if a room simulation 
is the goal.  

 

Predelay Parameter Range : 0 to x milliseconds  



Time between Direct Signal and start of Reverb portion.  

The more space between you and walls or other reflective 
objects, the greater the Predelay.  

 

Reverb Time Parameter Range : 0.1 to x.x seconds  

The greater the enclosed(!) volume of the space you're 
in, the longer the reverb time. This is of course true only 
to a certain extent. The larger the room or chamber, the 
louder your source signal needs to be to produce any 
significant level of reverb tail. A good way to demonstrate 
this is to visit some huge cathedral and talk quietly. Then 
yell a bit and you'll actually hear some significantly loud 
reverb. The RT60 value is measured with a noise impulse, 
but the level at which that impulse was sent out should 
be known too.  

Many reverb effects let you set different reverb times for 
different frequency bands. Most reverb units on PC and 
Mac architectures provide two bands, so you get to set 
the reverb time for each frequency band individually.  

 

Reverb Damping Usually a Highshelf and/or a Lowshelf EQ with variable 
Frequency.  

These EQs are applied continuously to an evolving reverb 
of a piece of audio. Over time, as the reverb fades, so do 
certain frequencies, either in the lower or higher 
frequency range. The more less-reflective surfaces the 
sound bounces around from, the more the reverb is 
dampened the higher frequencies.  

Freeverb features a Damping parameter that dampens 
the upper frequencies.  

 

Reverb EQ Usually a Highshelf and/or Lowshelf EQ with variable 
Frequency.  

These EQs are only applied to the output of the reverb or 
perhaps even just the reverb portion of the Reverb effect. 
Some reverbs have Highshelf and Lowshelf EQs for the 
Early Reflections as well.  



Freeverb has both a Hicut and Lowcut parameter.  

 

Here's a screenshot taken from the reverb plugin Renaissance Reverberator by 
Waves.  

 
reproduced with permission  

Here we have the Highshelf and Lowshelf EQs for Damping(left) and for the final 
output(right). The upper middle display depicts the Early Reflections placement 
and level, as well as the Reverb portion start and fading. Above this display is the 
Reverb Type selector. This changes the placement and level of the Early 
Reflections. The Size slider has influence on the Early Reflections as well.  

Blank concrete will reflect sound quite well across the frequency spectrum. A large 
thick curtain or padded walls will reflect sound poorly. A large club filled with 
people sounds completely different from an empty one. People, comfy chairs, 
curtains, carpets, beds and many more objects reflect only part of the sound that 
hits them.  
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Delay 
What is a Delay ? 

This effect uses a RAM buffer to store the audio for a certain amount of time, after 
which it outputs this audio.  



The RAM buffer will not always be just large enough to store the amount of audio 
set by the current delay time, but will actually be considerably larger sometimes, 
because many delay effects allow for their delay parameter to automated.  

 
  

 

Multi-Tap Delays 

This effect simply incorporates several discrete delay lines, each with its own delay 
time, level(amplitude) and panning. The feedback parameter is usually shared by 
all delays in a multi-tap delay. Some multi-tap delays feature a modulation section 
that modulates the delay times, which can be used to create chorus effects.  

 

Common parameters of a digital Delay 

Delay Time Parameter Range : 0.000 to xxx.xxx seconds  

The upper boundary of this parameter(xxx.xxx) depends on 
the amount of RAM in the hardware unit, or the amount of RAM 
reserved by the software plugin. For software plugins, the 
programmers or designers of the plugin set this upper 
boundary.  

The delay software plugin Supertap by Waves for example 
comes in two flavours on Protools TDM systems. One allows for 
delays of up to two seconds, but another version 
accommodates delay times of up to six seconds. This is due to 
the availability of RAM on the DSP hardware of a TDM system. 
The native(->CPU) version of this plugin for Windows for 



example only allows for delays of up to four seconds in length, 
but there are delay plugins that allow for delays of several 
minutes.  

 

Feedback Today's delay units and plugins will feature one of several 
different types of feedback parameters :  

a) Percentage Range : 0 to 99(or 100)%  
This is used by most hardware units and some software 
plugins. It determines the amount of a delayed signal to be 
sent back to the RAM buffer. The same delay time is applied. 
This is the most common parameter type for feedback.  

b) Decay Time : 0.1 to xx seconds  
A slightly different approach. The plugin or hardware unit 
determines the amount of delayed signal, that it sends back in 
to its RAM buffer, itself. Some may find this more intuitive. It 
isn't widely used however.  

c) Feedback Delay Time : 0.000 to xxx.xxx seconds  
This is like an additional delay line that takes the already 
delayed signal as input. This kind of parameter also requires a 
level setting, which is usually a percentage parameter, like a).  

   

EQs & Filters Many delay plugins feature highshelf and/or lowshelf EQs, or 
they feature highpass and/or lowpass filters. These EQs or 
filters usually process each delay. The idea behind this is 
usually to simulate distance, because with increasing distance, 
the lower and higher frequencies are dampened.  

Hi- & Lowshelf EQs 

• Gain : -xx to xx 
dB  

• Frequency: 20 Hz 
- 20 kHz 

Low- & Highpass Filters 

• Frequency: 20 Hz - 20 
kHz  

• Filter Strength : 6, 12, 
18 or 24 dB/Octave 

 

PANNING These are the most common types of stereo panning 
parameters you'll find.  

LEFT RIGHT LEFT RIGHT LEFT RIGHT 

-63 +64 
   

0% 100% 
   

-100% 100% 

Simply a panning control for the delay. The feedback 



parameter may also have its own panning control.  
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Chorus 
What is a Chorus ? 

Basically it's a Delay with the delay time is being modulated by an LFO ( Low 
Frequency Oscillator).  

This section is being written. In the meantime here is an illustration of what a 
Chorus effect does.  
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File Edit View Project Generate Effect Analyze  

Effects Menu 

Audacity includes many built-in effects and also lets you use plug-in effects (VST 
plug-ins) in the MacOS and Windows versions. You can download many free VST 
plugins at http://www.databaseaudio.co.uk. Loads of information is also available 
at http://www.kvr-vst.com. 

To apply an effect, simply select part or all of the tracks you want to modify, and 
select the effect from the menu. Titles which end in an ellipsis (...) will bring up a 
dialog asking you for more parameters. 



There are four classes of effects and they are all applied the same way. These are  

Internal Effects, VST Effect Plugins(Windows/Mac only), Nyquist Effects and LADSPA 
Effects(Linux only).  

Internal Effects 

Amplify... 

This effect increases or decreases the 
volume of a track or set of tracks. 
When you open the dialog, Audacity 
automatically calculates the maximum 
amount you could amplify the selected 
audio without causing clipping (from 
being too loud). 

Bass Boost... 

This is a safe, smooth filter which can 
amplify the lower frequencies while 
leaving most of the other frequencies 
alone. It is most effective if you don't 
try to boost too much; 12 dB is usually 
just right. 

Echo... 

A simple delay line. 

This effect repeats the audio you have 
selected again and again, softer each 
time. There is a fixed time delay 
between each repeat. 

First select the audio you want to apply 
the effect to. You may want to first add 
silence to the end of your track(s) so 
that the echo has plenty of time to die 
out. When you select "Echo..." from the 
Effect menu, Audacity will ask you for 
two numbers.  

The first number is the amount of delay 
between the echos, in seconds. The 
second value is the decay factor, which 
is a number between 0 and 1. A decay 
factor of 0 means no echo, and a decay 
factor of 1 means that each echo is just 

Invert 

This effect flips the audio samples 
upside-down. This normally does not 
affect the sound of the audio at all. It is 
occasionally useful, for example when 
the left and right channels of a song 
both contain equal amounts of vocals, 
but unequal amounts of background 
instruments. By inverting one of the 
channels and not the other, the vocals 
will cancel each other out, leaving just 
the instrumentals. Obviously this only 
works if the exact same vocal signal is 
present in both of the channels to begin 
with. 

Noise Removal... 

This effect is ideal for removing 
constant background noise such as 
fans, tape noise, or hums. It will not 
work very well for removing talking or 
music in the background. 

Removing noise is a two-step process. 
In the first step, you select a portion of 
your sound which contains all noise and 
no signal, in other words, select the 
part that's silent except for the noise. 
Then choose Noise Removal... from 
the Effect menu and click Get Profile. 
Audacity learns from this selection what 
the noise sounds like, so it knows what 
to filter out later. 

Then, select all of the audio where you 
want the noise removed from and 
choose Noise Removal... again. This 
time, click the "Remove Noise" button. 
It may take a few seconds or longer 



as loud as the original. A value of 0.5 
means that its amplitude is cut in half 
each time, so it dies out slowly. Smaller 
values will make it die out even more 
quickly. 

The Echo effect is very simple and is 
not intended to be used in place of a 
Reverb effect, which simulates the 
sound of a room, concert hall, stage, or 
other natural environment. Audacity for 
MacOS and Windows comes with 
FreeVerb, a free VST Reverb plug-in. 
See FreeVerb, below, for more 
information. 

Note that if you set the decay value to 
1.0, you can use Echo to create loops 
that repeat as long as you want any 
never change volume. 

Fade In 

Applies a linear fade-in to the selected 
audio. For a logarithmic fade, use the 
envelope tool. 

Fade Out 

Applies a linear fade-out to the selected 
audio. For a logarithmic fade, use the 
envelope tool. 

FFT Filter... 

This effect is fully functional but the 
dialog box is unfortunately still under 
construction. You can still use it, but 
there are no axes to tell you which 
frequencies are which, or how much 
gain you're applying. 

This is the most general type of filter. If 
you're careful, you can use it to 
highlight exactly the frequencies you 
want. However, doing an FFT filter is 
more likely to result in artifacts, 
especially if the filter you draw is not 
smooth. 

depending on how much you selected. 

If too much or not enough noise was 
removed, you can Undo (from the Edit 
menu) and try Noise Removal... again 
with a different noise removal level. 
You don't have to get a new noise 
profile again if you think the first one 
was fine. 

Removing noise usually results in some 
distortion. This is normal and there's 
virtually nothing you can do about it. 
When there's only a little bit of noise, 
and the signal (i.e. the voice or the 
music or whatever) is much louder than 
the noise, this effect works well and 
there's very little audible distortion. But 
when the noise is very loud, when the 
noise is variable, or when the signal is 
not much louder than the noise, then 
the result is often too distorted. 

Future versions of Audacity may 
include improved versions of this effect. 

Phaser... 

The name "Phaser" comes from "Phase 
Shifter", because it works by combining 
phase-shifted signals with the original 
signal. The movement of the phase-
shifted signals is controlled using a Low 
Frequency Oscillator (LFO). 

Reverse 

This effect reverses the selected audio 
temporally; after the effect the end of 
the audio will be heard first and the 
beginning last. Some people reverse 
small portions of audio to make 
inappropriate language unintelligible, 
while others believe you can hear 
subliminal messages if you listen to 
speech backwards. You can also create 
interesting sound effects by recording 
natural events and reversing the audio. 



Wahwah... 

Just like that guitar sound so popular in 
the 1970's. 

This effect uses a moving bandpass 
filter to create its sound. A low 
frequency oscillator (LFO) is used to 
control the movement of the filter 
throughout the frequency spectrum. 

The WahWah effect automatically 
adjusts the phase of the left and right 
channels when given a stereo 
recording, so that the effect seems to 
travel across the speakers. 

  

VST Plug-ins 

To use a VST plug-in effect, put the effect in the directory (folder) called "VST", 
which should be in the same directory where Audacity resides. If there is no 
directory called VST, create one. The next time you launch Audacity, any plug-ins 
you added will appear in the Effect menu. 

Freeverb2... 

Audacity for Mac OS and Windows 
comes with a VST plug-in called 
Freeverb, which is in version 2 (hence 
"Freeverb2"). This effect implements a 
versatile and high-quality reverb effect. 

Getting a good reverb sound depends a 
lot on the source audio and can take a 
lot of experimentation. One good 
strategy is to select a small portion of 
audio (a few seconds) and try to add 
reverb. Listen to it, then Undo and try 
it again with different settings. Keep 
doing this until you've found the 
settings you like the sound of best, and 
then Undo one last time, Select All, 
then apply the effect to your entire 
recording. 

There are a lot of parameters to 
Freeverb2: Room size, Damping, 
Predelay, Lowpass, Highpass, Wet 

If you set the dry level to 0 and the wet 
level to -infinity, it's like standing right 
in front of the singer in a tiny room - all 
you can hear is the singer, and no 
reverb. A good place to start is to set 
both the dry level and wet level to 0 
dB. However, you may want to 
experiment with lowering the dry level 
while you are experimenting with the 
sound of the reverb. 

The room size parameter is self-
explanatory. The smallest room size 
setting creates a quick, bright reverb, 
while the largest setting creates a long, 
drawn-out, and dark reverb. The 
damping parameter controls how the 
sound bounces off the walls - i.e. if it is 
mostly reflected or absorbed. 

The predelay controls the delay 
between the dry signal 



level, and Dry level. 

Let's start with the wet and dry levels. 
Freeverb works by taking your audio 
signal and modifying it to create the 
reverberated sound, i.e. the sound you 
hear echoing off the walls of the room. 
This is called the "wet" part of the 
effect. 

This is mixed together with the original 
sound, which is called the "dry" part of 
the effect, to produce the combination 
of direct (unreverberated) and indirect 
(reverberated) sound, which is what 
you would naturally hear. If you set the 
dry level to -infinity and the wet level 
to 0 dB, the result is something like 
standing outside of a concert hall: you 
can only hear the reverberated sound. 

(unreverberated) and the wet signal 
(reverberated) - usually there is some 
predelay because of the time it takes 
sound waves to travel from the sound 
source to the nearest wall, and to the 
microphone. Larger predelays are 
suitable for creating an effect of a 
larger room. 

Finally, the lowpass and highpass filters 
can be used to make the reverberated 
sound lower or higher. Increasing the 
lowpass filter filters out the high 
frequencies, and similarly increasing 
the highpass filter filters out the low 
frequencies. 

  

Nyquist Plugins 

To use a Nyquist effect, put the effect in the directory (folder) called "nyquist", 
which should be in the same directory where Audacity resides. Upon installation, 
some nyquist scripts are included, so you needn't worry about creating this 
directory. The next time you launch Audacity, any plug-ins you added will appear 
in the Effect menu. 

LADSPA Plugins 
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Frequently Asked Questions 

I. General II. Installation 



1. Is Audacity really free? 
Why?  

2. Who developed 
Audacity?  

3. How can I help to 
improve Audacity?  

4. I found a bug! Now 
what?  

5. Can I include or sell 
Audacity on a CDROM ?  

1. Windows: What do I do with the .exe file?  
2. Windows: How do I uninstall Audacity?  
3. Mac: What do I do with the .sit file?  
4. Unix: Why do I get failed dependencies 

when installing from the RPM?  
5. Unix: Why do I get an error while loading 

the shared library libwx_gtk.so?  

III. Using Audacity 

1. How do I mix two tracks together?  
2. Can I remove the vocals from a recording?  
3. When I try to record harmonies with myself, why are the two tracks out of 

sync? 
4. Why doesn't Audacity ship with an MP3 encoder?  

 

General 

1. Is Audacity really free? 
Why? 

Yes, in almost all senses. Audacity is 
not only distributed free of charge, but 
you are also free to do almost 
anything you want with it.  
 
Audacity is distributed under the terms 
of the General Public License (GPL). 
You are free to use this program for 
personal or commercial purposes. You 
are also free to give it away or sell it. 
The source code to this program is 
freely available on the web, and you 
are free to modify it for your own use, 
however any changes you make must 
also be distributed under the GPL.  
 
Audacity was build using wxWindows, 
a software library which is released 
under the less-restrictive LGPL. For 
more information, please visit 
http://www.wxwindows.org.  
 
The authors of Audacity decided to 
release it under the GPL for many 

Installation 

1. Windows: What do I do with 
the .exe file? 

From the browser, select the option to 
"Run from current location". This 
launches the Audacity setup program, 
which will install the Audacity program 
files and create an entry in the start 
menu.  
 
If you already downloaded the file, just 
double-click on it to start the installer.  
 
If you prefer not to use the Installer 
program, you can also download 
Audacity as a ZIP file, which you can 
decompress using WinZip. 

2. Windows: How do I uninstall 
Audacity? 

Audacity can be uninstalled by opening 
Add/Remove Programs in the Control 
Panel. Select "Audacity" from the list 
and click the button "Add/Remove". This 
launches the Audacity uninstall 



reasons. Some of us do it out of 
generosity. Some of us do it for moral 
reasons, because we feel that all 
software should be free, while others 
of us believe that there is a need for 
both free and commercial software in 
the world.  
 
One reason Audacity is free is so that 
it will be more popular. Many of us 
would rather see a million people 
happily using Audacity for free than 
have a thousand people pay us. Most 
users are more friendly when they get 
something for free.  
 
Yet another reason is that it 
encourages collaboration. If Audacity 
was shareware, it is unlikely that 
dozens of people around the world 
would have contributed code, bug 
fixes, documentation, and graphics. 

2. Who Developed Audacity? 

Audacity was started in the fall of 
1999 by Dominic Mazzoni while he was 
a graduate student at Carnegie Mellon 
University in Pittsburgh, PA, USA. He 
was working on a research project 
with his advisor, Professor Roger 
Dannenberg, and they needed a tool 
that would let them visualize audio 
analysis algorithms. Over time, this 
program developed into a general 
audio editor, and other people started 
helping out.  
 
Today, Audacity is developed using 
Sourceforge, an online site that allows 
people around the world to collaborate 
on free software projects. See 
http://www.sourceforge.net for 
more information. Dozens of people 
have contributed to Audacity, and 
progress is continually accelerating. 

3. How can I help to improve 
Audacity? 

There are many ways you can help. If 

program. 

3. Mac: What do I do with the 
.sit file? 

You need a recent version of StuffIt 
Expander. StuffIt Expander comes with 
all Macintoshes and is usually configured 
by default with all Mac web browsers. If 
Audacity does not decompress 
automatically, drag "audacity.sit" to 
StuffIt Expander to decompress it.  
 
There is no need to install Audacity. Just 
drag the Audacity folder to your 
Applications folder, or wherever else you 
would like to put it. To uninstall, just 
drag the entire folder to the trash. 

4. Unix: Why do I get failed 
dependencies when installing 
from the RPM? 

First, ensure that the wxGTK is 
installed; a link can be found from our 
Linux page - 
http://audacity.sourceforge.net/linux.ht
ml. Be sure that you use the appropriate 
version of wxGTK - Audacity 1.0 
requires wxGTK 2.2.9, and it will not 
work with any other version. 

5. Unix: Why do I get an error 
while loading the shared library 
libwx_gtk.so? 

This could be one of two problems:  
- If you installed the wxWindows RPM, 
be sure to run "ldconfig" (as root) so 
your system knows about the new 
library.  
 
- If you installed wxWindows from 
source, it may have been installed in 
/usr/local, but /usr/local/lib may not be 
in your library path. Add /usr/local/lib to 
the file "/etc/ld.so.conf" and then run 
"ldconfig". You may also want to add 
"/usr/local/bin" to your path, so that 
programs can find the "wx-config" 



you are a programmer and you know 
C++, we can always use more 
developers. We especially need more 
Windows and MacOS programmers, as 
many of the current developers prefer 
Linux.  
 
If you are bilingual, you can help us 
translate Audacity into another 
language.  
 
If you are good at writing, you can 
help us write documentation and 
tutorials.  
 
Finally, anyone can submit bug reports 
and suggestions. The more detailed, 
the better.  
 
If you would like to help out in any 
one of these ways, please email the 
developers at audacity-
devel@lists.sourceforge.net. You 
may also want to go to the 
Sourceforge web site and join the 
mailing list yourself. 

4. I found a bug! Now what? 

The most important thing when 
reporting a bug is to be as specific as 
possible. Give us enough information 
that we can reproduce the bug 
ourselves, otherwise it's unlikely that 
we'll be able to fix it.  
 
Be sure to let us know what operating 
system you run (such as Windows 98, 
MacOS 9.1, RedHat Linux 7.1, etc.) 
and any other information about your 
computer that you think might be 
relevant.  
 
Then, can you reproduce the bug? If it 
happens consistently, tell us the exact 
sequence of events which causes the 
bug to occur. If you get an error 
message, make sure you send us the 
exact text of the error message.  
 
We want to squash all of the bugs! 
Thanks for taking the time to help us 

utility. 

Using Audacity 

1. How do I mix two tracks 
together? 

Audacity mixes automatically. All you 
have to do is import two tracks into the 
same project, which you can do using 
the "Import Audio" command in the 
Project menu, or simply by dragging the 
two audio files to Audacity. When you 
press the record button, Audacity 
generates a new track automatically, 
also.  
 
In order to save your mix, you can 
either Export the project, which will 
automatically mix all of your tracks 
together, or you can select your tracks 
and use the "Quick Mix" command in the 
Project menu. 

2. Can I remove the vocals from 
a recording? 

With some stereo recordings, it is 
possible to remove the vocals because 
of the way in which the recording was 
mixed at the studio. Often, the vocals 
are placed in the exact center of the 
recording, while all other instruments 
are slightly off-center. If you subtract 
the right channel from the left channel, 
the vocals get completely canceled out, 
leaving only the other instruments.  
 
This only works on some 
recordings!  
 
To attempt this in Audacity, import a 
stereo recording, then click on the track 
pop-up menu (the little down-arrow 
next to the name of the track) and 
select "Split Stereo Track". Now select 
the lower track (the right channel) and 
use the "Invert" effect (from the Effect 
menu). Finally, use the track pop-up 
menus to make both channels Mono 



track them down. 

5. Can I include or sell 
Audacity on a CDROM ? 

Basically the same as the first 
question, so that is a big YES. You are 
also free to do almost anything you 
want with it. We do like to hear about 
it of course, but as long as you comply 
with the GNU Public License, you'll be 
OK. This means that you need to make 
any changes you make to Audacity 
available, including the source code. 
The source code doesn't need to be on 
the CDROM, but it should be available 
via the Internet for example. 

channels, and then mix them together 
using Quick Mix. If you're lucky, the 
vocals will be gone. 

3. When I try to record 
harmonies with myself, why are 
the two tracks out of sync? 

This is normal and it happens because 
there is a small delay between when 
Audacity starts playing sound and when 
it actually reaches your speaker. 
Audacity does not automatically try to 
correct for this delay, and you must do 
it manually.  
 
To correct this delay, use the Time Shift 
tool to slide one of the tracks over until 
they line up. Note that you can use the 
tool while you are listening to the 
recording. 

4. Why doesn't Audacity ship 
with an MP3 encoder? 

Unfortunately, the algorithm to encode 
or create MP3 files is patented, and 
Audacity would not be able to include 
an MP3 exporting algorithm without 
either charging a fee or violating the law 
in many countries.  
 
As a compromise, Audacity comes with 
the ability to use other MP3 encoders, 
which you must download separately. It 
is up to you to make sure you are in 
compliance with any licensing 
restrictions imposed by MP3 encoders.  
 
For more information, see the page on 
Exporting MP3 files. 
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